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A lektor megjegyzései

PICkit 2 programozó és hibakereső működésének 
ismertetése

Jelen dokumentumot készítette: Varga László

Lektorálta: Juhász Róbert

1 A lektor megjegyzései

Az alkotás öröme mindig is megfogott. Ettől mindig fiatalnak érzi az ember magát, hiába 
múlnak el  felette  az évek.  Különösen nagy örömöt jelent  számomra,  hogy a szerző egyik régi 
kedves tanítványom.

Amikor még belekezdtünk ebbe a projektbe, akkor még fogalmam sem volt róla, milyen 
nagy  fába  vágtuk  a  fejszénket  (köszönhetően  a  Microchip  mérnökeinek).  Azonban  mindezen 
nehézségeket  legyűrve  elkészült  a  mű.  Azt  kell  mondjam,  hogy  nagyon  jól  sikerült,  minden 
elismerésem Varga Lászlónak (Boci). Igazi precíz mérnöki munka volt ez a javából, nem túlzok 
talán, ha azt mondom, hogy sokkal jobb lett, mint az eredeti!

Remélem még  sok  ilyen  remekmű fogja  elhagyni  kezedet,  amihez  ezúton  is  sok  sikert 
kívánok:

Juhász Róbert
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A szerző megjegyzései

2 A szerző megjegyzései

Még  2009-ben  döntöttünk  úgy,  hogy  tervezünk  egy  a  PICkit  2  feladatait  ellátni  képes 
áramkört  THT1 technológiával.  A gyári  kapcsoláson  kisebb  módosításokat  eszközöltünk,  ennek 
következtében aktualizálni kellett  a Microchip Firmware programját is.  A megtervezett  áramkör 
utánépítésének megkönnyítése céljából szükségessé vált egy leírás elkészítése.

Mikor a dokumentációt elkezdtem írni úgy gondoltam, hogy röviden bemutatom az elkészült 
kapcsolást, néhány szót ejtve a módosításokról, a működésről. Az áramkör használatához azonban 
elengedhetetlen a programozó szoftver és a gyári PICkit 2 működésének ismerete. A dokumentáció 
többszöri  átolvasás  és  tisztázás  után  kerül  nyilvánosságra,  azonban sajnos  így sem redukálható 
nullára  a  szemantikai  és  stilisztikai  hibák  száma.  Az  esetleges  problémákat  a 
http://plc.mechatronika.hu weblapon üzemelő fórumon, a PICkit 2 topicban lehet jelezni.

A leírás  elkészítése  során  elsősorban  az  érthetőségre  és  a  szövegkohézióra  törekedtem. 
Néhány kevésbé fontos részletre terjedelmi okok miatt nem tudtam kitérni. Feltételeztem, hogy az 
olvasó  tisztában  van  az  elektronika  alapjaival.  Véleményem  szerint  a  következő  ismeretanyag 
megszerzése elengedhetetlen a mikrovezérlőkkel való megismerkedés előtt:

➢ Analóg áramköri ismeretek
• Áram, feszültség, teljesítmény, ellenállás, kapacitás, induktivitás fogalma, számítások
• Karakterisztika fogalma, értelmezése
• Ohm törvény alkalmazása a gyakorlatban
• Kirchhoff törvények, feszültség- és áramosztás
• Félvezetők  (dióda,  bipoláris  tranzisztor,  FET)  működése,  munkapont  beállítás, 

alkalmazási példák erősítő és kapcsolóüzemben
• BODE diagramok
• Integrált áramkörök tulajdonságai, határértékek és paraméterek értelmezése
• Műveleti erősítő és alapáramkörei

➢ Digitális technika alapjai
• Digitális és diszkrét jel értelmezése
• Számrendszerek (decimális, bináris, hexadecimális)
• Logikai függvények
• Kombinációs és sorrendi hálózatok vizsgálata, tulajdonságai
• TTL, CMOS áramkörök
• A legfontosabb digitális technikai elemek

➔ Kapuk
➔ Kódoló, Dekódoló, MUX, DEMUX, Aritmetikai áramkörök
➔ Tárolók
➔ Számlálók
➔ Regiszterek

• Átjárás az analóg és a digitális világ között (AD, DA átalakítás)

1 Through Hole Technology – furatszerelt technológia.
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A szerző megjegyzései

➢ Számítástechnikai alapismeretek
• A számítógép neumanni felépítése, alapelvek
• Egycímes architektúra
• Mikroprocesszor belső felépítése
• A mikrovezérlő és a mikroprocesszor közötti különbség
• Perifériák illesztése a mikrovezérlőhöz
• Programtervezés, szoftverfejlesztés lépései
• Programozás gépi kódban, az assembly nyelv megjelenése
• Magas szintű programnyelvek szükségessége és korlátaik

A dokumentációban a kapcsolási rajzokon a magyar szabványos rajzjeleket használtam, a 
szakkifejezések  ismertetésekor  törekedtem  az  angol/magyar  megfelelőjük  szerepeltetésére  is  – 
minimum  lábjegyzet  szintjén.  A  mértékegységekre  vonatkozó  magyar  helyesírási  szabályt  – 
miszerint a számérték és a mértékegység között szóköz használata kötelező – tudatosan szegtem 
meg. Úgy gondolom, hogy nem csak nem esztétikus, de egyenesen félrevezető ez a fajta írásmód, 
ezért az angol szabály szerint a mértékegységek szóköz nélkül követik számértékeiket.

A leírás  –  Abonyi  Zsoltnak  (okl.  villamosmérnök)  köszönhetően  –  javításra  került.  Itt 
szeretnénk köszönetet mondani neki, hogy a hibák feltárásával segítette munkánkat. Többek között 
módosítottuk a  Target csatlakozófelület menüpontot, valamint a klónáramkör kapcsolási rajzát és 
nyáktervét.
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Bevezetés

3 Bevezetés

A PICkit 2 a Microchip cég olcsó és megbízható programozásra és hibakeresésre is alkalmas 
–  a  PC  oldal  felé  USB  interfésszel  ellátott  –  eszköze.  Ismeri  a  legtöbb  microchip  flash 
mikrovezérlőt, valamint soros EEPROM memóriát (a részletes listát megtaláljuk a PICkit 2 v2.xx2 
programozó szoftver  Help menüjének  ReadMe pontjában – vagy MPLAB IDE fejlesztőkörnyezet 
esetén a C:\Program Files\Microchip\MPLAB IDE\Readmes alapértelmezett útvonalon3).

Az eredeti PICkit 2 firmware-e és kapcsolási rajza nyilvános, ezért sokan utánépítették az 
áramkört. Kis kutatómunka után az interneten számos verziót találunk – amelyek funkciójukban és 
az  ebből  adódó bonyolultságukban lényeges  eltéréseket  mutathatnak.  Amennyiben úgy döntünk 
hogy egy ilyen klónverziót építünk meg az eredeti termék megvásárlása helyett mindig figyelmesen 
olvassuk el a hozzá tartozó dokumentációt. Lehetséges változtatások:

• Az eszköz nem működik együtt 3,3 voltos rendszerekkel4.
• A Programmer – To – Go funkció nem használható5.
• PGD, PGC lábak leválasztása programozóként történő használat során6.
• Egyes alkatrészek más típusokkal történő helyettesítése7.

A klónáramkör kiválasztása során ügyeljünk arra, hogy működő és nekünk megfelelő verziót 
építsünk meg. Nézzünk utána az adott honlapnak, a készítőnek különböző információs csatornákon 
(pl. ismerősök véleménye, hiteles fórumok). A megépítéshez ha lehet olyan áramkört válasszunk 
amihez részletes leírás, esetleg bemérési, élesztési útmutató tartozik. 

A mellékletben egy a Juhász Róbert honlapján megtalálható PICkit 2 áramkört ismertetünk.

2 A program legfrissebb verziója ingyenesen letölthető a Microchip honlapjáról.
3 A PICkit 2 szoftvere, és az MPLAB beépített pluginja nem feltétlenül ugyanazokat a mikrovezérlőket ismeri.
4 Kihagyható a műveleti erősítővel felépített 5V to 3V3 áteresztő tranzisztoros feszültségszabályozó áramkör.
5 A Programmer – To – Go funkció (6.3.3.1. fejezet) elhagyása egyszerűsíti az áramkört, és csökkenti a költségeket 

(nincs szükség a két 24LC512 soros EEPROM memóriára).
6 Háromállapotú bufferek, vagy analóg kapcsolók használatával elérhetjük ezt a funkciót, de természetesen ez 

többletalkatrészt jelent.
7 Az egyes klónok tervezői gyakran módosítják az eredeti alkatrészlistát amihez általában célszerűségi okok vezetnek 

(pl. bipoláris tranzisztor helyett FET használata így csökkentve az ellenállások számát, valamint a fogyasztást, vagy 
egyes az angolszászok körében közkedvelt áramköri elemek helyett hazánkban is kapható azokkal egyenértékű 
alkatrész használata).
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4 A jegyzetben használt fogalmak tisztázása

A dokumentációban  használt  kifejezések  megértéséhez  a  legtöbb  esetben  elegendő  az 
elektronikával  hobbi  szinten  foglalkozók  általános  tudása.  Ebben  a  fejezetben  az  esetleges 
félreértések  elkerülése  végett  az  általam  használt  fontosabb  szakkifejezések8 hátterét  kívánom 
megvilágítani.

Hardver: A számítógép fizikai része – az áramköri egységek, vezetékek összességét tekintjük 
hardvernek. A PICkit  2 esetében a hardvert  a szerelt  (beforrasztott) 
NYÁK a szükséges csatlakozóval, és kábellel ellátva jelenti.

Szoftver: „A számítógép  azon  része,  amelyért  a  hardvert  rugdossuk.”  Komolyra  fordítva: 
szoftvernek tekintjük a számítógép memóriájában tárolt programot – 
és a hozzá tartozó adatot –, amely segítségével a hardvert különböző 
feladatok  ellátására  tudjuk felhasználni.  A PICkit  2  esetén  szoftver 
alatt  a  PC-re megírt  PICkit  2 v2.xx,  vagy MPLAB IDE programot 
értjük.

Firmware9: Egy speciális szoftvertípus, amely nélkül a hardveregység az alapvető feladatait se 
tudja  ellátni.  Ilyen  a  PC  BIOS-a,  vagy  a  DVD  írókban  lévő  – 
EEPROM-ban tárolt – program. PICkit 2 esetén a PIC18F2550 típusú 
mikrovezérlőben tárolt programot tekintjük firmware-nek.

Klónáramkör: Egy  már  meglévő  gyári  alkalmazás  funkcióinak  megvalósítása.  Egy  klón 
megtervezésének általában anyagi  okai  vannak.  A klón áramkörnek 
nem kell  feltétlenül   ugyanolyan  felépítéssel  rendelkeznie,  mint  az 
eredeti gyári alkalmazás, valamint egyes alfunkciókban is eltérhet – 
azonban az alapvető működésben meg kell hogy egyezzen vele.

Host, Target: Emuláció,  hibakeresés  és  programozás  során  az  emulátort/debuggert/programozót 
HOST, míg a céláramkört TARGET néven illetjük.

8 A jegyzetben a legtöbb helyen megpróbálom közérthető ún. konyhanyelven (is) megfogalmazni a tartalmat. Itt olyan 
definíciókat találhat a kedves olvasó, amelyek a leírás felépítésébe nem illeszkedtek.

9 Az adott szó még nem honosodott meg a hazai szakmai életben, ezért a jegyzetben az angolos írásmódot választjuk. 
A magyar helyesírás szabályai szerint alkalmazható még a kiejtéshelyes förmver, ill. létezik egy öszvér megoldás is: 
firmver.
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VDD, VSS: Integrált áramkörök esetén a pozitív tápfeszültségre VDD, vagy VCC, míg a negatív 
tápfeszültségre10 VSS, vagy VEE szimbólumokkal hivatkozunk. A D a 
drain, a C a kollektor, az S a source, míg az E az emitter elektródára 
utal.  Általánosan igaz,  hogy TTL és  ECL11 áramkörök  esetén  VCC, 
VEE, míg CMOS áramköröknél VDD és VSS jelölésekkel találkozunk, 
azonban néhány dokumentáció eltérhet ettől a szabálytól.

Programmer/Debugger: A PICkit  2  képes  egy  programozó  és  egy  debugger  funkcióját  is 
ellátni. Programozás során a céláramkörbe töltjük, onnan kiolvassuk, 
és/vagy összehasonlítjuk a kívánt programot. Hibakeresés12 során egy 
speciális ún. debug programot égetünk a mikrovezérlőbe, ez lehetővé 
teszi,  hogy  a  program  futását  kedvünk  szerint  manipulálhassuk 
(futtatás,  megállítás,  léptetés,  programmemória,  és  regiszterek 
kiolvasása). A PICkit 2 debugger funkciója alacsonyabb rendű, mint 
egy emulátor. A hibakereső funkcióhoz szükségünk van a céláramkör 
erőforrásaira (RB6, RB7, MCLR , oszcillátor, stb.), valamint néhány 
megkötéssel  is  meg  kell  barátkoznunk:  pl.  korlátozott  számú,  és 
komplexitású töréspontok, WDT nem használható, stb13.

Égető: Az első programozott áramkörökben (PROM14) még szó szerint égetéssel tudtuk kialakítani 
a  nekünk  szükséges  bitmintát.  Diódákat  –  később  tranzisztorok 
átmeneteit – égette el az üzemi áramnál jóval nagyobb értékű árammal 
a programozó az egyik logikai állapothoz – ezzel szakadást létrehozva 
az adott helyen15. Az első programozókat így égetőknek nevezték el, 
és ez a kifejezés – bár a FLASH technológia már más elven alapul – a 
mai napig megmaradt a hőskor iránti tiszteletből.

MCU: Microcontroller  (mikrokontroller),  mikrovezérlő,  μC.  Egytokos  mikroszámítógép,  amely 
egy  chipben  egyesíti  a  számítógép  részeit  (CPU,  memória,  I/O 
egység).

10 PIC mikrovezérlő esetén a negatív tápfeszültség a GND, azonban léteznek olyan integrált áramkörök, amelyek 
kettős tápfeszültségről üzemelnek, és ezeknek 3 tápbemenetük lehet (VDD, GND, VSS).

11 Emittercsatolt logika (Emitter Coupling Logic) a mai leggyorsabb logikai áramkörcsalád – bipoláris tranzisztorokból 
épül fel.

12 A hibakeresést debugolásnak nevezzük. Az angol bug (bogár) kifejezést használjuk minden rejtélyes hibaforrásra az 
informatikában.. 1947-ben az egyik hőskori számítógép a MARK II meghibásodott, és a hiba forrása egy molylepke 
volt. A mérnökök belső köreiben már ezen esemény előtt is bugnak hívták a hibákat, azonban a történet után a 
kifejezés széles körben népszerűvé vált. Ma már kevesen vannak akik ne ismernék a bug-hiba, debug-hibakeresés 
összefüggést. A történet egyébként nem csak egy szép mese, szegény molylepke be is került a mérési jegyzőkönybe.

13 Részletesebben l. 7.1.2.1. fejezetben.
14 Programmabble Read Only Memory – a felhasználó által egyszer felprogramozható csak olvasható memória.
15 A diódák eredetileg rövidzárat képviseltek a mátrix szerkezetben.
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5 PICkit 2 hardver bemutatása

5.1 Az áramkör használata

Az  eszközön  (5.1.1.  ábra)  található  3  állapotjelző  LED,  egy  nyomógomb,  egy  ICSP 
csatlakozófelület és egy USB csatlakozó16.

A LED-ek funkciója:

Power: A zöld színű LED világít, ha az áramkör kap tápellátást 
az USB porton keresztül17.

Target: A sárga színű LED jelzi, hogy a céláramkör számára a 
tápellátást a PICkit 2 biztosítja.

Busy: A piros színű LED programozás során jelzi a foglalt állapotot.

16 A PICkit2 fel van szerelve egy műanyag füllel, amellyel a mechanikai rögzítését végezhetjük el (pl. felfűzhetjük egy 
kulcstartóra).

17 A LED csupán a feszültség meglétét (>2V) és helyes polaritását jelzi, annak pontos értékét csak mérés útján tudnánk 
meghatározni.
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5.1.1. ábra: PICkit 2 programozó és hibakereső
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A nyomógomb funkciója: Amennyiben  engedélyezve  van  a  Programmer  → Write  on  PICkit  
button funkció  a  gomb  megnyomásának  hatására  a 
megnyitott  *.hex fájl  beégetésre  kerül18.  A 
nyomógombnak a firmware-frissítés (6.14. fejezet), és a 
Programmer-To-Go funkció  (6.3.3.1.  fejezet)  során is 
fontos szerepe van.

ICSP csatlakozófelület: A Microchip egy 6 pólusú hüvelysort19 használ az áramkörben történő 
soros égetés biztosításához. A 5.1.1. és a  5.1.2. ábrán 
lévő háromszög jelzi az 1-es lábat. Az ICSP-ről az 7.2. 
fejezetben találunk részletesebb információt.

Az egyes céláramkörök esetén mindig fordítsunk kiemelt figyelmet a csatlakozó bekötésére, 
mert az eltérő lábkiosztás mind a programozó, mind a céláramkör tönkremeneteléhez vezethet.

18 Ez a lehetőség igen kényelmes lehet ugyanazon hex fájl több PIC-be történő beégetése esetén – hiszen nem kell a  
PC-n lévő szoftverrel foglalkoznunk, csupán a nyomógombot „kezelnünk”.

19 Lábtávolság: 2,54mm. Csatlakoztatható: 0,6 mm négyzetes keresztmetszetű tüske.
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5.1.2. ábra: ICSP csatlakozófelület lábkiosztása

1 : V PP / MCLR
2 : V DD Target
3 : V SS GND

4 : ICSPDAT / PGD
5 : ICSPCLK / PGC
6: AUX



5.2 Az áramkör működése

A Microchip cég az áramkör kapcsolási rajzát és a működtető program gépi kódú, valamint C nyelvű forrását nyilvánosságra hozta 20, így a 
működést viszonylag egyszerűen meg tudjuk érteni.

20 PICkit2 User Guide  

5.2.1. ábra: PICkit2 hardveregység kapcsolási rajz 1/2

http://www.microchip.com/Microchip.WWW.SecureSoftwareList/secsoftwaredownload.aspx?device=en023805&lang=en&ReturnURL=http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&dDocName=en023805#


5.2.2. ábra: PICkit2 kapcsolási rajz 2/2
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5.2.1 Az áramkör felbontása tipikus részekre

5.2.1.1 Oszcillátor konfiguráció

A  PIC  mikrovezérlők  tartalmaznak  egy  belső 
oszcillátor  áramkört  (5.2.1.1.1.  ábra),  amelyhez 
kívülről elég ha a kvarckristályt és a hozzá tartozó 
hidegítőkondenzátorokat csatlakoztatjuk. Az RS soros 
ellenállás  opcionális  –  az  AT strip  cut21 kiképzésű 
oszcillátor  esetén  javasolt.  Részletes  információért 
keresd  fel  az  alábbi  weboldalakat: 
http://www.icmfg.com/glossary.html

http://www.icmfg.com/crystalfaqs.html#q6

http://www.foxonline.com/techdata.htm

Bár  a  PIC18F2550  típusú  mikrovezérlő  tartalmaz 
belső RC oszcillátort is, a fejlesztők úgy döntöttek22, 
hogy  az  órajelet  egy  külső  kvarckristállyal 
biztosítják.  

21 A strip cut és a cut verzió méretben, formában, és számos elektronikai paraméterben eltérést mutat. A strip cut –  
általában,  azonos  frekvencián  –  nagyobb  soros  ellenállással,  szélesebb  frekvenciaválasztékkal  rendelkezik, 
szélesebb  hőmérséklet  tartományban  működik,  azonban  kisebb  a  kristály  hangolhatósága,  nagyobb  a  mérete 
(tokozása).

22 Többek között az USB kommunikáció és a pontos órajel szükségessége miatt.

13/117

5.2.1.1.1. ábra: PIC18F2550 
mikrovezérlő kristály és kerámia 

oszcillátor konfigurációja

http://www.foxonline.com/techdata.htm
http://www.icmfg.com/crystalfaqs.html#q6
http://www.icmfg.com/glossary.html
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A  PIC  mikrovezérlők  adatlapja  egy 
táblázatban (5.2.1.1.2. ábra) megadja, hogy 
a támogatott frekvenciákhoz milyen értékű 
hidegítőkondenzátor alkalmazása célszerű. 
A  Microchip  a  PICkit2  áramkörénél  a 
megadott 15pF helyett 22pF-ot választott – 
a  kapacitás  növelésével  nő  az  eszköz 
stabilitása,  azonban  ezzel  együtt  a 
feléledési  idő  is.  Az  oszcillátort  hidegítő 
kondenzátor  kiválasztásánál  nem  csak  az 
eszköz adatlapját kell figyelembe vennünk. 
Általánosan  elfogadható,  hogy  ha  a 
feléledési  idő  nem  kritikus,  akkor  a 
stabilitás  érdekében  nagyobb  értékű 
kapacitást használunk – azonban a konkrét 
értéket  mindig  a  tesztek  során  tapasztalt 
működés alapján határozzuk meg.

5.2.1.2 Host23 ICSP csatlakozófelület
A J1-el jelölt ICSP csatlakozó a felhasználó számára nem hozzáférhető24.  Az eszköz első 

felprogramozását25 teszi lehetővé, amelyet a Microchip gyárilag elvégez.

5.2.1.3 Host USB csatlakozófelület
A PC-vel történő kommunikáció szabványos USB porton keresztül  került  biztosításra.  A 

PICkit2 támogatja az USB 2.0 szabványban rögzített full-speed adatátvitelt. Az USB csatlakozó – 
mechanikai kialakítása miatt – rosszul nem köthető be, ezért védelem nem került kiépítésre.

23 A PICkit  2-vel  történő munkánk során alapvetően  két  mikrovezérlő együttműködéséről  beszélhetünk.  A HOST 
jelzésű PIC18F2550 típusú mikrovezérlő foglal helyet  a PICkit  2 -ben, míg a TARGET jelzésű mikrovezérlő a 
céláramkörben.

24 Ezért a csatlakozón védelmek nincsenek kiépítve.
25 A későbbi firmware frissítés (6.14. fejezet) már az USB porton keresztül, a PC oldali szoftver segítségével történik.
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5.2.1.1.2. ábra:
Kondenzátorértékek az alkalmazható  
oszcillátorfrekvenciák függvényében
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5.2.1.4 Nyomógomb illesztése a mikrovezérlőhöz

A nyomógomb egy pergésmentesítő áramkörön keresztül került kiépítésre (5.2.1.5.1. ábra). 
Az RB5 lábra a T időnél gyorsabban érkező impulzusok nem jutnak el. T-t feszültségosztás alapján 
tudjuk számolni: SW aktiválásánál RB5 lábon kisebbnek kell lennie a potenciálnak 0,8V-nál26:

U L=U T⋅
X C

X CR2
=U T⋅

1
2 Π f C
1

2 Π f C R2

= 
2 Π f C
2 Π f C  U T⋅

1
12 Π f RC

27

U L

U T
= 1

12 Π f R C

U T

U L
=12 Π f R C

f =

UT

U L
−1

2 Π R C
=

5V
0,8V

−1

6,28⋅10kΩ⋅10μF
=5250

628
=8,36 HzT=120ms

28

Mindemellett a nyomógombot egy szoftveres prellmentesítő rutin29 segítségével kérdezi le a 
PICkit2.

26 Katalógus adat. A nyomógomb elengedésekor UH magas szintet kellene megvizsgálnunk (2V) ez azonban nagyobb 
frekvenciát, így kisebb periódusidőt eredményezne.

27 UT-vel a tápfeszültséget (5V) UL-el a TTL alacsony szint maximális értékét (0,8V) jelöltük.
28 A gyakorlatban, méretezési eljárásnál adott a frekvencia, amely feletti jeleket már nem kívánunk figyelembe venni. 

Ebben  az  esetben  olyan  ellenállás-kondenzátor  párt  választunk,  amelyek  esetében  igaz,  hogy  a  kondenzátor 
reaktanciája az adott frekvencián már jóval (1/10) kisebb, mint az ellenállás értéke. Az R2 ellenállás felhúzó szerepet 
is betölt, ezért értéke nem tetszőleges (1kΩ-100kΩ).

29 200 ms.
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5.2.1.4.1. ábra: RC taggal pergésmentesített nyomógomb

5V

R1
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RB5
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5.2.1.5 Változtatható target VDD feszültség előállítása

A PICkit 2 képes együttműködni a hagyományos 5V-os, és az újabb 3V3-os rendszerekkel 
is. A megfelelő működés biztosítására az eszközt kiegészítették egy szabályozható tápfeszültség-
előállító részáramkörrel.

Az  RC2 lábon  egy  belső  periféria30 segítségével  PWM  jelet  állít  elő  a  mikrovezérlő, 
amelyből egy elsőfokú aluláteresztő szűrő31 segítségével létrejön az U1 ponton jelzett – a kitöltési 
tényezővel  arányos  amplitúdójú – DC feszültség.  Az IC-vel  jelölt  műveleti  erősítő  a  kimenetét 
képes a  tápfeszültség szintjéig (5V) emelni32.  Alaphelyzetben az U1 pontot kötnénk a műveleti 
erősítő neminvertáló bemenetére, míg a visszacsatolást az invertáló bemenetre vezetnénk, a negatív 
visszacsatolás.  biztosítására.  A  kimenet  pedig  közvetlenül  felhasználható  szabályozott 
feszültségként.  Ez a kimenet azonban erősen korlátozott  áram tekintetében. A T jelzésű booster 
tranzisztor  invertáló működése33 miatt  a  visszacsatoló ág a  neminvertálóra,  a  bemenet  pedig az 
invertáló  ágba  kerül  (5.2.1.6.1.  ábra).  A  műveleti  erősítővel  soros  feszültség  visszacsatolást 
alkalmaztunk, a tranzisztor áteresztőként34 erősítő üzemben (3,3V) és túlvezérelt (telített) állapotban 
(5V) működik. R ellenállás nagyfrekvenciás üzemben korlátozná35 a CGS kapacitás okozta nagy IG-t.

30 Capture-Compare-PWM modul
31 A szűrő itt az átlagoló szerepét tölti be.
32 Csak CMOS technológiával készült ún. Rail-to-Rail erősítő használható
33 P típusú FET-et kell alkalmaznunk, mert csak a tápfeszültséghez képest tudunk vezérelni. A kimeneten  nagyobb 

feszültség előállításához a FET-nek kisebb ellenállást kell képviselni, vagyis jobban kell nyitnia – ehhez a műveleti 
erősítő kimenetén kisebb potenciál előállítása szükséges, és ebből a folyamatból adódik az invertálás.

34 Felfogható  egy változtatható  ellenállásként,  ami  pl.  3V3  táp  mellett  olyan  értékű  ellenállást  képez,  ami  olyan 
feszültségosztót alkot a céláramkör okozta terheléssel, hogy utóbbin 3,3V essen függetlenül annak értékétől.

35 A T jelzésű FET a PWM jel kitöltési tényezőjével arányos DC feszültséget kap a vezérlő (Gate) lábán, ezért az R 
ellenállásnak csupán elvi jelentősége van.
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5.2.1.5.1. ábra: Szabályozható VDD tápfeszültség előállító áramkör
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Az  áramkör  működését  érdemes  az  U3 ponttól  visszafelé  követni.  Erre  a  pontra  kell 
biztosítani egyik esetben 3,3V, másik esetben 5V feszültséget. Az U4 ponton lévő feszültség (1,65V; 
2,5V) az U3 pontról kerül visszacsatolásra az R3, R2 által alkotott 1:1 feszültségosztón keresztül.

A műveleti  erősítő  – működéséből  adódóan – az U1 ponton is  ugyanekkora feszültségre 
törekszik. Az RC2 lábon előállított PWM jelet egy aluláteresztő RC36 szűri meg – így lesz az U1 

ponton a kitöltési tényezővel arányos feszültség (33% → 1,65V; 50% → 2,5V).

A műveleti erősítő kimenetének feszültsége a T jelzésű tranzisztor Threshold potenciáljának 
és az U1 pont feszültségének függvénye (1,65V → U2~UTH ; 2,5V → U2~5V).

Itt jegyeznénk meg, hogy mivel a FET a visszacsatolókörben van, ezért káros tulajdonságai 
–  zaj,  a  Threshold  feszültség  szórása,  hőmérsékletfüggés,  stb.  –  nem befolyásolják  a  kimeneti 
feszültséget.

36 Itt átlagolóként működik.
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5.2.1.5.2. ábra: VDD feszültséget előállító áramköri rész jelalakjai
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5.2.1.6 VPP programozófeszültség előállítása
A programozófeszültség 5V-os rendszerek esetén 13V, 5V míg 3,3V-os rendszer esetén 3,3V. 

A PICkit 2 tartalmaz egy diszkrét elemekből felépített PWM vezérlésű Step Up37 típusú DC-DC 
feszültségkonvertert.

37 Feszültségnövelő.
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5.2.1.6.1. ábra: VPP előállító áramkör
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Az  áramkör  működésének  megértéséhez  először  vizsgáljuk  meg  a  5.2.1.6.2.  ábrán  látható  elvi 
elrendezést.

Mind az Ube, mind az Rt-n eső Uki feszültség DC. A K kapcsolót vezérlő feszültség kitöltési 
tényezőjével tudjuk beállítani a kimeneti feszültséget. A K kapcsoló nyitott állapotában a bemeneti 
feszültség – leszámítva a diódán eső részét – a terhelésre jut38 és közben tölti a pufferkondenzátort. 
A K kapcsoló zárt állása esetén a bemeneti feszültség az L tekercset tölti. A D dióda meggátolja,  
hogy  a  kimeneti  feszültséget  földeljük,  ebben  az  állapotban  a  C  jelzésű  kondenzátor  látja  el 
energiával  a  terhelést.  A  K  kapcsoló  nyitásakor  az  L  tekercsben  tárolt  energia  a  bemeneti 
feszültséget erősítve jelenik meg a kimeneten. Mivel a tekercsben indukált feszültség és a bemeneti 
feszültség  összeadódik39,  ezért  a  kimeneten  a  bemeneti  feszültségnél  nagyobb értékű feszültség 
keletkezik. Minél tovább töltjük a tekercset, ill. minél nagyobb az induktivitás értéke, a bemenethez 
hozzáadott  indukált  feszültség  annál  nagyobb  lesz40.  Az  áramkörrel  célszerűen  szabályozott 
feszültséget  szoktunk  előállítani,  vagyis  a  kimeneti  feszültséget,  vagy  annak  arányos  részét 
visszacsatoljuk,  és  ennek megfelelően állítjuk be a  kitöltési  tényezőt.  A PICkit2  áramkör ezt  a 
visszacsatolást  szoftveres  úton  valósítja  meg,  egy  feszültségosztó  és  a  belső  A/D  átalakító 
segítségével méri az előállított feszültséget (RA0 láb), és ennek függvényében változtatja a CCP41 
modul kitöltési tényezőjét állító regiszter értékét.

Visszatérve a 5.2.1.6.1. ábrához beláthatjuk, hogy a K kapcsolóként ebben az elrendezésben 
a  T1 tranzisztor  üzemel,  L → L1,  D → D,  C → C jelzéssel  megtalálható.  Az RB2-es  lábat  a 
programozó üzemelteti, amennyiben ezen a lábon +5V van, a T3 jelzésű tranzisztor a kollektor és 
emitter pontját rövidre zárja, földre kötve R5 ellenállást. Ebben az esetben a T2 tranzisztor az R4 

ellenállással párhuzamosan kapcsolt RBE ellenállását úgy módosítja, hogy ki tudjon nyitni, vagyis 
rajtuk 0,6V essen (R4=100kΩ, R5=10kΩ).

38 A tekercs DC feszültségre rövidzárként viselkedik, a D dióda nyitóirányban van előfeszítve.
39 Lenz törvénye szerint a tekercsben indukált feszültség az őt keltő hatással (töltőáram) ellentétes lesz.
40 Természetesen  a  tekercs  töltésének  idejére  a  kondenzátornak  kell  árammal  ellátnia  az  áramkört,  ezért  ezt  az  

időszakot nem tudjuk minden határon túl növelni.
41 Capture/Compare/PWM  –  kiolvasás/összehasonlítás/impulzus  szélesség  moduláció.  Mi  a  modult  PWM  jel 

előállítására alkalmazzuk.
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5.2.1.6.2. ábra: Feszültségnövelő DC-DC konverter
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T2 tranzisztor kinyitásával (kollektor-emitter rövidzár) az előállított feszültség a VPP pontra kerül. 
Ha a programozó az RB5 lábon 0 potenciált hoz létre, akkor a T3 tranzisztor kollektora és emittere 
között nagy ellenállást (szakadást) hoz létre, ezáltal meggátolja T2 tranzisztor kinyitását, hiszen a 
bázisa az R4 ellenálláson keresztül ugyanakkora potenciálra van felhúzva, mint az emittere. Az RA5 

lábat a felhasználó üzemelteti. Amennyiben 5V-ot adunk a T4 tranzisztor bázisára az R8 ellenálláson 
keresztül,  akkor  az  kinyit,  és  a  VPP pontot  R7 ellenálláson  (100Ω)  keresztül  a  földre  húzza  (

MCLR  On42 állapot).  Ellenkező  esetben  –  RA5 lábon  +5V –  a  T4 tranzisztor  szakadásként 
viselkedik, és elengedi a VPP pontot ( MCLR  Off43).

5.2.1.7 VDD feszültség csatlakoztatása
A 5.2.1.5.1. ábrán már bemutattuk,  hogy a PICkit2 hogyan állítja elő a Target számára a VDD 
feszültséget (U3). Ezt a potenciált le kell tudnunk választani a céláramkörről, hiszen lehet, hogy 
saját táppal rendelkezik. Az ehhez szükséges áramköri részt a Microchip mérnökei a 5.2.1.7.1. ábra 
szerinti elrendezésben oldották meg.

42 MCLR  asserted
43 MCLR  released
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5.2.1.7.1. ábra: VDD csatlakoztatása a céláramkörhöz
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Az U3 pontot a T2 jelzésű P-FET kapcsolja a céláramkörre. A tranzisztor vezérlését az RB4-
es láb segítségével a mikrovezérlő végzi el a szoftveres beállítás figyelembevételével44. Az RA1-es 
lábat analóg bemenetként konfigurálták a firmware-ben, ezért a belső A/D átalakító segítségével 
közvetlenül tudjuk mérni a VDDTGT pont feszültségét45.

Tegyük  fel,  hogy  a  céláramkör  tápellátását  a  PICkit2  biztosítja.  Amennyiben  a  mért 
feszültség kisebb, mint a beállított U3-UD-Umax

46, akkor a PICkit2 a VDD lábon rövidzárat jelez 
(5.2.1.7.2. ábra). A VDDTGT pont közvetlenül csatlakozik a target-hez, ezért a D jelzésű Schottky47 
dióda gondoskodik a céláramkörtől esetlegesen érkező nagyfeszültség leválasztásáról.

 Elképzelhető  az  az  eset,  hogy  a  beállítás  szerint  a  PICkit  2-nek  kellene  ellátnia  a 
céláramkört tápfeszültséggel,  de az ennek ellenére rendelkezik saját energiaforrással.  Ekkor a D 
jelzésű dióda megakadályozza a tápok összeakadását – az ilyenkor meginduló nagy értékű áramot a 
PICkit2 szoftvere érzékeli, és leállítja a tápellátást.

Abban az esetben, ha az eszköz rendelkezik saját tápforrással az RA1 ponton tudjuk mérni 
ennek értékét.  Ebben az üzemmódban a T1 jelzésű FET az R4 ellenálláson keresztül megadja a 
földpotenciált a VDDTGT pontra. A GND-re azért van szükség, mert  ha a céláramkör tápellátása 
mégse kielégítő – vagyis a VDDTGT pontra nem kapcsol feszültséget –   akkor az A/D átalakító 
segítségével 0V-ot  tudunk mérni48.

R1, R2 ellenállások a tranzisztorok – vezérlés nélküli – alaphelyzetbe (szakadás) állítására 
szolgálnak.

44 A PICkit2 program Tools → Target VDD Source menüpontjában tudjuk megadni.
45 R5  ellenállás  védelmi  célokat  szolgál  –  megakadályozza,  hogy  a  target  felől  érkező  nagyobb  feszültségek 

tönkretegyék a PICkit2 programozó és hibakereső eszközt. 
46 A VDD tápon megengedett maximális feszültségesés – alapértelmezetten: XV.
47 A helyes működés során bekövetkező kis feszültségesés okán választottak Schottkyt.
48 Egyébként a kapcsolásból, és nyáktervezésből adódó zavarfeszültséget érzékelnénk.
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5.2.1.7.2. ábra: VDD feszültség hiba
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5.2.1.8 Soros EEPROM memóriák illesztése a mikrovezérlőhöz

A Programmer-To-Go  funkció  biztosításához  szükség  van  a  beégetni  kívánt  programot 
eltárolni  képes  memória  áramkörre.  A Microchip  a  saját  fejlesztésű  24LC512  típusú  alacsony 
fogyasztású 512 kiB-os I2C49 buszon kommunikáló EEPROM memóriája mellett tette le a voksot. A 
két memória IC címe nem változtatható – hardveresen került kialakításra (0, ill. 1). A 5.2.1.8.1. 
ábrán  láthatjuk  a  memóriák  mikrovezérlőhöz  csatlakoztatását.  Az  SCK50,  és  SDA51 lábakat  a 
Microchip ellátta a szabványos felhúzó ellenállásokkal. A PIC18F2550 típusú mikrovezérlőben az 
I2C kommunikációs port hardveresen ki van építve, ezért az SCK, SDA lábak az RB1, RB0 lábakra 
kerültek. Ezen felül a Microchip alkalmazza a hardveres írásvédelmet is (WP52), ez az RC6 lábra 
csatlakozik.

49 A Philips cég által kifejlesztett Inter IC kommunikációs busz segítségével két vezetéken történő kommunikációt 
valósíthatunk meg. Részletesebb információért l. www.muszeroldal.hu/measurenotes/i2c_hu.pdf.

50 Serial ClocK
51 Serial DatA
52 Write Protect
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5.2.1.8.1. ábra: I2C buszos EEPROM memóriák csatlakoztatása a  
mikrovezérlőhöz
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5.2.1.9 Állapotjelző LED-ek

A LED-ek soros ellenálláson keresztül csatlakoznak a mikrovezérlő lábaihoz, másik pontjuk 
5V-ra, ill. földre kötve – funkcióiknak megfelelően (5.1. fejezet).

Az  ellenállások  értéke  470Ω,  így  aktív  állapotukban  az  áramigényük: 

I D=
U T−U D

R
=5V−2V

470Ω
=6,38 mA

• D1 zöld színű LED közvetlenül az USB tápra van kötve, így jelezve annak meglétét.

• D2 piros színű LED-et az RC0 lábon kiadott magas szint aktiválja. A HOST foglaltságát 
jelzi, ill. hibaüzenetek közlésére alkalmas.

• D3 sárga jelzésű LED-et az RB4 lábon kiadott alacsony szint aktiválja. A PICkit2 által a 
TARGET számára szolgáltatott tápfeszültséget kapcsoló FET állapotáról nyújt információt 
(ha világít, akkor a PICkit2 a TARGET számára biztosította a tápfeszültséget).
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5.2.1.9.1. ábra: Állapotjelző LED-ek csatlakoztatása a mikrovezérlőhöz
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5.2.1.10 Target ICSP csatlakozófelület
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5.2.1.10.1. ábra: ICSP csatlakozó védelmi áramköre
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A céláramköri  csatlakozó  kialakításánál  figyelemmel  kell  lennünk  a  target  felől  érkező 
helytelen jelekre (rossz csatlakozókiosztás a céláramkörön, hibás kialakítás, forrasztás, beültetés). A 
PICkit2 áramkör szoftveres áramkorláttal53 van ellátva.

A 5.2.1.10.1. ábrán lévő tranzisztorok gondoskodnak az ICSP vonalak VDD szinten54 történő 
megfogásáról,  ha  van  tápfeszültség55 –  ennek  hiányában  a  vonalat  maximum  0,6V-ig  engedi 
emelkedni56. A PGC, PGD és AUX lábakon olyan céláramkörrel is kommunikálhatunk, amely nem 
tolerálja a TTL jelszintet, ezért szükséges, hogy a feszültségszintet a céláramkör tápfeszültségénél 
maximalizáljuk.

Mind a tápfeszültséget (a céláramkörét), mind a programozófeszültséget a PICkit 2 a belső 
A/D átalakító  segítségével  méri,  és a gyárilag megadott  hiszterézisnél  nagyobb eltérés esetén a 
tápfeszültséget lekapcsolja a céláramkörről, és a piros Busy LED gyors villogásával jelzi a hibát.

53 A PICkit  2  100mA áramigényt  jelez  a  PC  felé,  ezen  áramérték  átlépését  az  alaplapi  vezérlőáramkörnek  kell 
meggátolnia az operációs rendszer utasítása alapján.

54 Ez a céláramkör tápfeszültsége.
55 A D  jelzésű  diódán  eső  nyitóirányú  feszültség  közel  megegyezik  a  tranzisztorok  BE  diódáján  eső  maximális  

nyitóirányú  feszültséggel,  ezért  a  tranzisztorok  maximális  UE0 feszültsége  közel  megegyezik  a  VDD  pont 
feszültségével.

56 Az  R5 ellenálláson  keresztül  a  tranzisztorok  bázisukra  GND-t  kapnak,  ezért  az  emitterük  maximum ~0,6V-ra 
emelkedhet.
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6 PICkit 2 V 2.61 programozószoftver bemutatása

6.1 Telepítési útmutató

Töltsük  le  a  www.microchip.com/PICkit  2 
weboldalról  a  legújabb  szoftververziót  Windows57 
operációs rendszer alá. A honlap jobb felső sarkában 
láthatjuk a szoftverújdonságokat (6.1.1. ábra). 

57 A Microchip biztosít egy parancssoros verziót  is  a PICkit 2 működtetésére – Linux operációs rendszer alatt ez  
használható.
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6.1.1. ábra: Microchip PICkit 2 
programozó és hibakereső szoftver

6.1.2. ábra: Microchip PICkit 2 letöltés szekció

http://www.microchip.com/pickit2
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A telepítőcsomag igényli a .NET keretrendszert – amennyiben nem rendelkezünk vele, akkor 
a  honlapon  lefelé  görgetve  keressük  meg  a  Download szekciót  (6.1.2.  ábra)  és  válasszuk  a 
keretrendszert tartalmazó telepítőcsomagot. Itt megtalálhatjuk a PICkit 2 hivatalos – angol nyelvű – 
felhasználói útmutatóját, valamint több dokumentációt és szoftververziót is.

A telepítőcsomag zip tömörített formában áll rendelkezésünkre. Első lépésként csomagoljuk 
ki  valamilyen tömörítőszoftverrel,  vagy fájlkezelő programmal58.  Az így kapott  Setup.exe fájlt59 
indítsuk el és kövessük a telepítő program utasításait.

A  telepítő  végigvezet  minket  a  PICkit  2  szoftver  sikeres  installálásán  –  valamint 
figyelmeztet a termék szerzői jogvédettségére (6.1.3. ábra). A Next gombra kattintva60 válasszuk ki a 
telepítési útvonalat (6.1.4. ábra).

58 Használhatjuk a méltán népszerű Total commander-t vagy a Windows beépített tömörítőjét (Winzip) is.
59 A zip fájl tartalmaz még egy msi – microsoft telepítő információs – fájlt is
60 A telepítés során lehetőség van a billentyűzet alkalmazására is (TAB, Nyilak, Enter kombináció; vagy ALT + az 

opciófelirat aláhúzott karaktere; Kilépés: ESC).
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6.1.3. ábra:
Üdvözöljük a PICkit 2 telepítő varázslójában

http://www.totalcommander.hu/
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Az  útvonal  módosításához  kattintsunk  a  Browse (Tallózás)  gombra.  A  Disk  Cost...  
(Lemezterület) gomb  megnyomásával  megvizsgálhatjuk  a  merevlemezünk  foglaltságát.  Végül 
válasszuk ki, hogy kinek engedélyezzük a program használatát – mindenkinek (Everyone), vagy 
csak saját magunknak (Just me). A megfelelő beállítások után kattintsunk a Next (Tovább) gombra!

A következő  lépésben  (6.1.6.  ábra)  a  telepítő  közli  velünk,  hogy készen  áll  a  program 
felinstallálására a számítógépünkre – ha változtatni szeretnénk a beállításokon kattintsunk a < Back 
gombra, a telepítés folytatásához válasszuk a Next > opciót, valamint lehetőségünk van a telepítés 
megszakítására is (Cancel). 
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6.1.4. ábra:
A telepítés első lépése, célmappa kiválasztása

6.1.5. ábra: A telepítés második lépése
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Olvassuk  el  az  angol  nyelvű  licenc  szerződést  (6.1.6.  ábra)  és  ha  egyetértünk  vele61 
válasszuk az I Agree opciót, valamint kattintsunk a Next gombra.

A telepítő értesít minket (6.1.7. ábra), hogy az installáció sikeresen befejeződött, valamint 
figyelmeztet hogy mindig a legfrissebb Windows .NET keretrendszer összetevőt alkalmazzuk. A 
Close gombra kattintva lépjünk ki a telepítőből.

61 A szerződés elfogadása nélkül a szoftver nem telepíthető a számítógépre.
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6.1.6. ábra: A telepítés harmadik lépése, licenc  
szerződés elfogadása

6.1.7. ábra:
A telepítés negyedik lépése, kilépés az telepítőből
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6.2 Az első indítás

Indítsuk el a PICkit 2 programot az asztalon található parancsikon (6.2.1. ábra) segítségével, 
vagy a Start menüben válasszuk ki a telepített programok közül (6.2.2. ábra).
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6.2.1. ábra: PICkit 2 parancsikon

6.2.2. ábra: PICkit 2 program indítása a Start menüből
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A program bejelentkező felületét több objektumra bonthatjuk.

• Menubar (6.3.1.1. ábra)

• Device Configuration (6.5.1. ábra)

• PICkit 2 status (6.4.1. ábra)

• Programmer toolbar (6.7.1. ábra)

• VDD PICkit 2 (6.6.1. ábra)

• Program Memory Window (6.8.1. ábra)

• EEPROM Data Window (6.9.1. ábra)

• Special programming buttons (6.10.1. ábra)
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6.2.3. ábra: PICkit 2 bejelentkező felület
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6.3 Menürendszer ismertetése

6.3.1 File
Import  Hex: Lehetőségünk  van  gépi  kódú  fájlt 
beimportálni.  Az  Intel  Hexa  32  bites  formátuma 
támogatott.

Export  Hex:  A  mikrovezérlőből  kiolvasott  kódot 
exportálhatjuk Intel Hexa 32 bites formátumú fájlba.

Exit: Kilépés a programból.

A Fájl menü tartalmaz még egy File History menüpontot is62, ahol az utolsó négy importált 
fájlt tudjuk megnyitni.

6.3.2 Device Family
Baseline: Alapkonfiguráció  beállítása  (12  bites  PIC 
mikrovezérlők).

Midrange: Középkategória  (14  bites  PIC 
mikrovezérlők). Kiválaszthatjuk az alap (Standard), és 
a  már  minimum  1,8V-os  tápfeszültségről  üzemelő 
mikrovezérlőket (min 1,8V) is.

PIC18F: 16 bites63 PIC mikrovezérlők kiválasztása.

PIC18F_J_: 3,3V-os mikrovezérlők.

PIC18F_K_: Már 1,8V-ról is üzemelő mikrovezérlők.

PIC24: 16 bites64 mikrovezérlő család.

dsPIC33: 3,3V-os  mikrovezérlő  család  DSP65 
alkalmazásokhoz.

DsPIC30: 5V66-os  mikrovezérlő  család  DSP 
alkalmazásokhoz.

dsPIC30  SMPS: Mikrovezérlőcsalád  DSP 
alkalmazásokhoz, különösen kapcsolóüzemű tápokhoz.

62 Ameddig nem importáltunk be hex fájlt ez a menüpont nem látható.
63 Itt, és az előző két pontban is a bitszám a program memóriára vonatkozik, vagyis az utasítások hosszára. Mindhárom 

konfigurációban  olyan  mikrovezérlőket  találunk,  melyek  8  bites  adatokkal  dolgoznak.  A  programmemória 
szélességének változását a Harvard architektúra teszi lehetővé.

64 A bitszám itt és a következőkben az adatmemória szélességét jelöli.
65 Digital Signal Processing – digitális jelfeldolgozás.
66 A legtöbb mikrovezérlő már 2÷3V-os tápfeszültségről  is  üzemel,  azonban mindig ellenőrizzük az  adott  típust! 

adatlapján, hogy alacsonyabb feszültségről milyen órajellel képes még működni.
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6.3.1.1. ábra: Menüsor

6.3.1.2. ábra: Fájl menü

6.3.2.1. ábra:  
Eszközcsalád 
kiválasztása
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PIC32: 32 bites mikrovezérlő család.

KEELOQ® HCS: KEELOQ ugrókódos dekóderek.

EEPROMS: Soros EEPROM-ok

MCP250xx: Beépített  CAN-busszal  ellátott 
mikrovezérlők.

A  Device Family menüpontban választhatjuk ki, hogy a programozandó eszközünk mely 
családba  tartozik.  A későbbiek  folyamán  a  Device  Configuration ablakrészben  csak  ebből  a 
családból választhatunk magunknak konkrét típust (6.5. fejezet).

6.3.3 Programmer
Read Device: A  kiválasztott  eszköz  kiolvasása 
(Programmemória,  EEPROM adatmemória,  azonosító, 
konfigurációs bitek).

Write  Device: A kiválasztott  eszköz  felprogramozása 
(Programmemória,  EEPROM adatmemória,  azonosító, 
konfigurációs bitek).

Verify: A  kiválasztott  eszközből  kiolvasott  kódot 
(Programmemória,  EEPROM adatmemória,  azonosító, 
konfigurációs bitek) hasonlíthatjuk össze a programozó 
szoftverben tárolttal (pl. egy beimportált gépi kóddal).

Erase: A kiválasztott eszköz törlése67.

Blank Check: Ellenőrzi, hogy a céláramkör üres-e.

Verify  on  Write: Ha  be  van  jelölve,  akkor  a 
felprogramozás után automatikus ellenőrzés is történik.

Clear Memory Buffers on Erase: Ha be van jelölve az 
eszköz  törlése  során  a  szoftver  memória  pufferét  is 
törli.

Hold  Device  in  Reset: Ha  be  van  jelölve,  akkor  a 
programozó  az  MCLR / V PP lábat  alacsony szinten 
tartja (folyamatos reszetben), amennyiben nem jelöljük 
be, akkor ezt a lábat elengedi (háromállapotú kimenet) 
és  hagyja,  hogy  külső  felhúzás  hatására  az  eszköz 
elhagyja a reszet állapotot.

Alert Sounds...: A telepítés után a programozó szoftver 
nem  használ  hangjelzéseket,  ezen  azonban 
módosíthatunk  és  alapértelmezett  –  vagy  bármilyen 
saját68 – hangfájlt rendelhetünk a siker, veszély és hiba 
üzenetekhez (6.3.3.2. ábra).

67 Ezen opció választásakor a programozó hardver bulk erase funkciót végez, melynek során a kódvédelemmel ellátott 
PIC mikrovezérlő is törlődik.

68 A hangnak wav formátumban kell lennie.
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6.3.3.1. ábra:
Programozó menü
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Write  on  PICkit  Button: Egy  forrás  több  eszközbe 
történő égetése során nem kell a PC oldali szoftverrel 
bajlódni,  a  beimportált  fájlt  a  hardveren  található 
nyomógombbal többször is beégethetjük ha ez az opció 
be van jelölve.

Manual Device Select: Kézi eszközkiválasztás, ha be 
van jelölve ez az opció, akkor nekünk van lehetőségünk 
kiválasztani  az  eszközt  a  Device  Configure 
ablakrészben (6.5. fejezet).

PICkit  2  Programmer-To-Go...: A  PICkit  2 
programozó és hibakereső eszköz lehetőséget nyújt egy 
előre  a  hardverbe  töltött  program  PC  nélküli 
felprogramozására.  A funkciót  választva  egy varázsló 
segítségével  letölthetjük  a  PICkit  2  memóriájába  a 
beégetni kívánt programot (6.3.3.1. fejezet).
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6.3.3.2. ábra: Figyelmeztető hangjelzések beállítása
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6.3.3.1 Programmer – To – Go funkció használata

A PICkit 2 hardveregység tartalmaz két darab 24LC512 típusú soros EEPROM memóriát. 
Ezekbe letöltve a programot később PC és az azon futó szoftver nélkül is tudunk programozni. A 
PICkit 2-nek mindössze az 5V-os USB tápellátásra van szüksége.

A Help gombra kattintva további részleteket tudhatunk meg a Programmer-To-Go funkcióról 
– válasszuk a Next > opciót.
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6.3.3.1.1. ábra: Üdvözöljük a PICkit 2 programozás és  
indulás funkció varázslójában
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A következő ablakban láthatjuk a puffer tartalmát – ezek a beállítások kerülnek majd az 
EEPROM memóriába – valamint a tápellátás beállításait.

Device: Az előzőleg beállított eszköz típusát mutatja.

Buffer data source: Itt láthatjuk a kiválasztott forrást (teljes elérési úttal).

Code Protect: Kódvédelem engedélyezett e, vagy sem69.

Data Protect: Adatvédelem engedélyezett e, vagy sem.

Memory Regions: A programmemória és az EEPROM adatmemória fülnél lévő Enabled 
(engedélyezés)  opciók  függvényében  három  különböző 
beállítást olvashatunk.

Write entire device: A  teljes  eszköz  írása  (Programmemória  és  EEPROM 
adatmemória is)

Preserve EEPROM on write: Az  eszköz  írása  az  EEPROM  adatmemória 
kihagyásával.

Write EEPROM data only: Csak az EEPROM adatmemória írása.

Verify Device:Programozás után az eszköz ellenőrzése.

Power Settings: Állítsuk  be  a  programozás  során  alkalmazni  kívánt  tápfeszültségre 
vonatkozó beállításokat.

69 Alapértelmezetten  a  forrásfájl  beállításai  lesznek  irányadóak,  azonban –  ezt  felülírva  –  mind a  kód-,  mind  az  
adatvédelmet külön beállíthatjuk a Tools menüben.
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6.3.3.1.2. ábra: Programozás beállításai
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Target has its own power supply: Az  égetéshez  szükséges  VDD  feszültséget  a 
céláramkör biztosítja.

VDD < 4,5V use low voltage row erase:

Ha a tápfeszültség kisebb mint 4,5V row erase használata70.

Power target from PICkit 2 at 2,7 Volts:
A programozás során a VDD tápfeszültséget a PICkit 2 biztosítja71.

A  Next  > gombra  kattintva  egy  összegzést  kapunk  a  beállításokról  –  amennyiben  a 
tápfeszültség beállításával nem vagyunk megelégedve visszatérhetünk az előző ablakba a  < Back 
gomb  hatására  (a  Cancel opció  választásával  átállíthatjuk  az  egyéb  paramétereket  is). 
Megbizonyosodva a PICkit 2 hardver csatlakoztatásáról, kattintsunk a Download gombra.

Az összegzésben szereplő beállításokat a következő helyeken tudjuk módosítani:

70 Nem minden típusnál alkalmazható. Ha bejelöljük az opciót, akkor (VDD < 4,5V esetén) ún. row erase funkciót 
alkalmaz a PICkit 2 az eszköz törlésénél programozás előtt. Ez a kódvédelemmel ellátott PIC mikrovezérlők esetén 
hatástalan, vagyis ezeket nem fogjuk tudni felülírni.

71 Értékét a VDD ablakban (6.6. fejezet) módosíthatjuk.
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6.3.3.1.3. ábra: Letöltés paramétereinek összegzése
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Device: Válasszuk ki a  Device Family menüpontban (6.3.2.1.) az alkalmazni kívánt 
eszköz családját,  majd az eszköz kiválasztó ablakban (6.5.1. 
ábra) a konkrét típust.

Data Source: A  File  →  Import  Hex (6.3.1.2.  ábra)  menüponttal,  vagy  a  Ctrl+I 
billentyűkombinációt  alkalmazva  nyissuk  meg  a  beégetni 
kívánt hex fájlt.

Power Settings: A Tools → PICkit 2 Programmer – To – Go menüponttal megnyitott 
varázsló  második  lépésében  (6.3.3.1.2.  ábra)  válasszuk  ki  a 
tápellátás beállításait.

Memory Regions: A programmemóriához  (6.8.1.  ábra)  és  az  EEPROM  memóriához 
(6.9.1.  ábra)  tartozó  ablakban  használjuk  az  Enable 
(engedélyezés) opciót (36. oldal).

Device will be verified: A  Programmer  →  Verify  on  Write opció  bejelölésével 
programozás során az eszközbe töltött program – írás után – 
kiolvasásra  és  a  beírandó  programmal  összehasonlításra 
(verify) kerül.

Fast Programming: Amennyiben a  Tools → Fast Programming opció be van kapcsolva, 
akkor a PICkit2 a lehető legnagyobb sebességgel próbálja meg 
beégetni az áramkört. Ha nem jelöljük be, akkor a programozó 
csökkenti a kommunikáció sebességét – ez hasznos lehet, ha a 
céláramkör beterheli az ICSP vonalakat.

MCLR kept asserted during & after programming:
MCLR láb magas szinten tartása programozás után (Programming → Hold Device in  

Reset).
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A 6.3.3.1.4. ábrán látható ablakban a varázsló közli velünk, hogy a letöltés befejezéséről a 
hardveregységen található sárga – Target jelzésű – LED villogása fog minket értesíteni.

A piros – Busy jelzésű – LED villogása informál minket az esetleges hibajelenségekről. A 
Next > gombra kattintva láthatjuk az egyes hibákhoz tartozó kódokat. A hibákat a nyomógomb 
működtetésével tudjuk törölni – egyszeri fellépésükkor a nyomógomb többszöri megnyomásával 
próbáljuk kiküszöbölni a hibát.
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6.3.3.1.4. ábra: Letöltés befejeződött
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Gyors villogás: tápfeszültség,  vagy  programozófeszültség  hiba.  A  gyári  PICkit  2 
sajnos  csak  nagyon  korlátozott  mértékben  –  60mA –  képes  ellátni 
árammal  a  céláramkört.  Egy  átlagos  pufferelés  (470÷1000μF)  is 
túlterhelheti  a  PICkit2-őt.  A  tápfeszültséget  mindig  a  céláramkör 
csatlakoztatása nélkül ellenőrizzük.

Két villogás: eszközazonosító  hiba.  Ellenőrizzük  a  PIC  típusát,  egyezik  e  az  előre 
megadottal. Vizsgáljuk meg a csatlakozást.

Három villogás: ellenőrzés nem sikerült. Amennyiben a kódvédelem be van kapcsolva 
a  hibaüzenet  normális  (ebben  az  esetben  nem  érdemes  ellenőrzést 
kérni, mert mindig nullákat olvas ki a mikrovezérlőből a programozó). 
Ha a  kódvédelem nem lett  aktiválva,  akkor  próbálkozzunk ismételt 
égetéssel,  hátha  valamilyen  sztochasztikus  zavar  jelentkezett  a 
programozás során.

Négy villogás:belső hiba történt.  Próbálkozzunk a PICkit  2 reszetelésével.  Ha nem oldja 
meg  a  problémát,  akkor  alkalmazzuk  újra  a  Programmer-To-Go 
funkciót.
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6.3.3.1.5. ábra: Programmer - To - Go hibakódok
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6.3.4 Tools
Enable  Code  Protect: Kódvédelem engedélyezése  (a 
forráskódban lévő konfigurációs bit felülbírálása).

Enable  Data  Protect: Adatvédelem engedélyezése  (a 
forráskódban lévő konfigurációs bit felülbírálása).

OSCCAL: Oszcillátor kalibrálása.

Target  VDD  Source: A  céleszköz  tápellátásának 
kiválasztása72.

Display  Unimplemented  Config  Bits: Az  eszközben 
nem megvalósított  konfigurációs  biteket  is  mutassa a 
szoftver.

Calibrate VDD & Set Unit ID...: A PICkit 2 által mért 
tápfeszültség kalibrálása,  és az eszköz azonosítójának 
beállítása (6.11. fejezet).

Use VPP First  Program Entry: Amennyiben be van 
jelölve,  akkor  a  PICkit  2  számára  engedélyezett  a 
csatlakozás,  és  felprogramozása  akkor  is,  ha  a 
konfiguráció  és  a  kód  olyan  hatással  van  a  PGD  és 
PGC  lábakra,  amelyek  megakadályoznák  a 
mikrovezérlőt  a  programozómódba  való  belépésben. 
Használata  megköveteli,  hogy  a  PICkit  2  adja  a 
tápfeszültséget.

Use  LVP  Program  Entry: Alacsony  feszültségű 
programozási  mód  engedélyezése.  Lehetővé  teszi  az 
LVP programozást,  ebben  az  esetben  a  mikrovezérlő 
PGM lábát az AUX vonalra kell csatlakoztatnunk.

Fast  Programming: Ha  be  van  jelölve,  akkor 
engedélyezve van a gyors programozás73.

UART  Tool...: A  PICkit  2  használható  UART 
eszközként (6.12. fejezet).

Logic Tool...: A PICkit 2 képes egy elég kezdetleges 3 
csatornás  logikai  analizátorként  is  működni  (6.13. 
fejezet).

Check  Communication: Kommunikáció  ellenőrzése 
(USB,  és  ICSP).  Az  eredményt  a  PICkit  2 
státuszablakban ellenőrizhetjük

72 Auto-Detect: a PICkit 2 hardveregység automatikusan felismeri, hogy a céleszköznek van e saját tápellátása, ha 
nincs, akkor biztosítja azt.
Force PICkit 2: A tápellátást a PICkit2 biztosítja.
Force Target: A tápellátást a céláramkör biztosítja.

73 A PICkit 2 a lehető legnagyobb sebességgel (~1Mhz) használja az ICSP vonalat. Ha az opciót nem jelöljük be,  
akkor a sebességet a PICkit 2 lecsökkenti (~250kHz), így növelve az eszköz stabilitását.

41/117

6.3.4.1. ábra: Eszközök
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Troubleshoot...:  Hibaelhárítás.  Egy  varázsló  (6.3.4.1. 
fejezet)  segítségével  ellenőrizhetjük  a  hardveregység 
legfontosabb paramétereit.

Download  PICkit  2  Operating  System:  A PICkit  2 
operációs rendszerének letöltése.

6.3.4.1 Hibaelhárítás

A PICkit 2 szoftver a Tools → Troubleshoot... menüpontban lehetőséget biztosít számunkra, 
hogy hibakeresést,  és  -elhárítást  végezzünk.  A hibakereső üzemmódot  a  sárga LED folyamatos 
világítása jelzi.

Kezdetnek  olvassuk  el  a  varázsló  kezdő  instrukcióit,  majd  a  Next  > gombra  kattintva 
kezdjünk hozzá a hibakereséshez, a Cancel gomb segítségével kiléphetünk a funkcióból.

A varázsló segítségével ellenőrizhetjük, hogy a PICkit 2 hardveregység helyesen működik, 
és helyesen csatlakozik az ICSP vonalakon keresztül a céláramkörhöz.

Válasszuk le a céláramkört a PICkit 2-ről74, az ICSP vonalakra csatlakoztassunk voltmérőt 
(DMM), oszcilloszkópot, és a következő lépésben mérjük az adott pontok potenciálját75.

74 Ez a lépés nagyon fontos! A hibakeresést először a terheletlen PICkit 2 áramkörön kell elvégeznünk.
75 A varázsló az adott lépésben grafikusan jelzi számunkra, hogy mely lábat vizsgáljuk éppen.
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6.3.4.1.1. ábra:
PICkit 2 hibaelhárító varázsló üdvözlő felülete
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Az első lépésben a VDD feszültséget fogjuk ellenőrizni. Állítsuk be a minimálisan szükséges 
feszültségszintet (ezt a programozni kívánt céláramkör határozza meg).

Kattintsunk a  Test gombra, és közben mérjünk rá a vonalra multiméter, és oszcilloszkóp76 
segítségével.

Amennyiben a 6.3.4.1.3. ábra szerinti sikertelen teszteredményt kapjuk77, vizsgáljuk meg a 
VDD vonal és a GND közötti impedanciát (ezt a mérést passzív panel esetén végezzük), valamint a 
csatlakozó épségét. A 6.3.3.1.4. ábrán látható üzenet esetén oszcilloszkóp segítségével ellenőrizzük 
a VDD vonal statikus voltát.

76 Az oszcilloszkópon láthatjuk az esetlegesen a tápvonalra szuperponálódott zavarjelet, valamint a tápvonal felfutási  
idejére is tudunk következtetni.

77 Ezt mindenképpen hasonlítsuk össze a valódi műszeres méréssel.
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6.3.4.1.2. ábra: PICkit 2 hardveregység ellenőrzése,  
1. lépés: VDD feszültség mérése

6.3.4.1.4. ábra:
Sikeres VDD teszt

6.3.4.1.3. ábra:
Sikertelen VDD teszt
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A Next > gombra kattintva lépjünk tovább a VPP feszültség vizsgálatára (6.3.4.1.6. ábra). A 
varázsló egy figyelmeztető ablakban (6.3.4.1.5.  ábra)  tájékoztat  minket arról,  hogy a következő 
tesztekhez szükség lesz a VDD feszültségre, amit az előző lépésben beállítottunk – kivéve ha a 
céláramkör biztosítja a tápfeszültséget.

A VPP feszültség ellenőrzése során a varázsló tájékoztat minket a beállított PIC mikrovezérlő 
családhoz tartozó programozó feszültség értékéről, majd ellát minket a szükséges instrukciókkal. A 
Test VPP gombra kattintva a Results ablakban látjuk a PICkit 2 által kiadott, mért, és szabályozott 
VPP programozó feszültséget – ezt ellenőrizzük multiméter, és oszcilloszkóp segítségével is.
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6.3.4.1.5. ábra:
PICkit 2 hibakereső varázsló figyelmeztető ablaka

6.3.4.1.6. ábra: PICkit 2 hibakereső varázsló, VPP 

feszültség ellenőrzése
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Amennyiben  Test  Passed üzenetet  üzenetet  kapunk  (6.3.4.1.7.  ábra),  ellenőrizzük  a 
programozófeszültséget multiméterrel is.

A /MCLR On gombra kattintva a programozó az  MCLR  lábat alacsony szintre húzza. 
Mérjük az MCLR  láb potenciálját – 0V-t kell jeleznie a műszernek. 

Az  /MCLR  Off gomb  hatására  a  PICkit2  elengedi  a  VPP lábat,  próbáljuk  felhúzni  egy 
ellenálláson keresztül 5V-ra, és ellenőrizzük a multiméterrel, hogy ez sikerült-e.

A  6.3.4.1.10.  ábrán  láthatjuk  a  hibakeresés  3.  lépését,  a  PGC  és  PGD  ellenőrzését. 
Lehetőségünk van magas (High (VDD)), ill alacsony szintbe (Low (GND)) billenteni az adott lábat, 
valamint beállíthatunk egy 30kHz-es 50%-os kitöltési tényezőjű TTL négyszögjelet (Toggle 30kHz).

45/117

6.3.4.1.7. ábra: VPP 
feszültség ellenőrzése sikeres

6.3.4.1.8. ábra:
MCLR láb nullába húzása

6.3.4.1.9. ábra:
MCLR láb elengedése
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A beállított értékeket ellenőrizzük multiméter, és oszcilloszkóp segítségével78.

Amennyiben mindent rendben találtunk a  Finished gomb megnyomásával befejezhetjük a 
hibakeresést.

78 Érdemes  a  két  lábat  egyszerre  is  mérni  különböző  beállítások  mellet,  így  fel  tudjuk  deríteni  a  „lábak 
összezáródásából” adódó hibát is.
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6.3.4.1.10. ábra: PICkit 2 hibakereső varázsló; PGC, 
PGD lábak ellenőrzése
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6.3.5 View

Single  Window: A teljes  kezelőfelület  egy  ablakban 
történő elhelyezése és egy egységként kezelése.

Multi Window: A memóriatérkép külön ablakba történő 
leválasztása.

Show Program Memory: Program memória mutatása 
(csak multi window beállításnál).

Show  EEPROM  Data: EEPROM  adatmemória 
mutatása (csak multi window beállításnál).

Associate/Memory  Displays  in  Front: Ha  az  opció 
nincs bejelölve, akkor a memória és a fő ablak teljesen 
elkülönül, amennyiben bejelöltük, akkor a főablakban 
történő módosítás magával vonzza a memóriaablakot is 
(pl. a főablak lecsukása a tálcára a memóriaablakot is 
lecsukja.).  Az  opció  használatára  csak  multi  window 
beállításnál van lehetőségünk.

6.3.6 Help

PICkit  2  User's  Guide: A  hivatalos  angol  nyelvű 
PICkit 2 felhasználói kézikönyv megnyitása.

Programmer – To – Go Guide: A Programmer – To – 
Go funkcióhoz tartozó kézikönyv megnyitása.

Logic  Tool  User  Guide: Leírás  a  PICkit  2  logikai 
analizátorként való használatáról.

44-Pin Demo Board Guide: A 44 lábú bemutatópanel 
leírása.

LPC Demo Board Guide: A kis  lábszámú (Low Pin 
Count)  bemutatópanelhez  tartozó  kézikönyv 
megnyitása.  (8,  14,  20  lábú  eszközök  támogatottak, 
részletes listához l. a kézikönyv.)

PICkit2 on the web: PICkit  2 a weben.  A menüpont 
hatására az alapértelmezett böngészőben megjelenik a 
Microchip  weboldalának  PICkit  2  részlege 
(www.microchip.com/pickit2).

ReadMe: Olvass  el  fájl.  Tartalmazza  a  támogatott 
eszközök  listáját,  és  a  használatukhoz  szükséges 
bekötést.

About: A PICkit 2 névjegye.

47/117

6.3.5.1. ábra: Nézet menü

6.3.6.1. ábra: Segítség menü

http://www.microchip.com/pickit2
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6.4 PICkit 2 csatlakoztatása

A  hardveregység  nem  igényel  különleges  meghajtóprogramot  (drivert).  A  windows 
operációs  rendszer automatikusan felismeri USB eszközként. Csatlakoztassuk az áramkört a PICkit 
2  programozó  szoftver  segítségével  (a  kommunikáció  automatikusan  megindul,  és  a 
státuszablakban látnunk kell ennek eredményét (6.4.1. ábra, 6.4.2. ábra).

Amennyiben  a  6.4.1.  ábra  szerinti  üzenetet  kapjuk,  akkor  valami  probléma  áll  fenn  a 
kommunikációban. Vizsgáljuk meg a PICkit  2 USB csatlakozójának épségét,  valamint a kábelt. 
Ellenőrizzük, hogy a PICkit 2-őt az operációs rendszer felismerte egyáltalán mint USB-s eszközt. 
Sajnos a Windows operációs rendszert használók esetében előfordulhat, hogy egy korábban indított 
és nem megfelelően befejezett programfolyamat (pl. MPLAB) lefoglalta az USB portot, és csak az 
operációs rendszer újraindítása oldja meg a problémát.

A Tools → Check Communication menüpont segítségével tudjuk a csatlakozási kísérletet 
megismételni.

A 6.4.2. ábra szerinti üzenet esetén a PICkit 2-őt felismerte a szoftver, rögtön ki is olvassa az 
azonosítóját. Erre azért van szükség, mert egyszerre töb PICkit 2-őt is használhatunk fejlesztésre, 
ilyenkor a fejlesztőrendszer mindig megkérdezi,  hogy mely azonosítójú PICkit  2-vel szeretnénk 
végrehajtani az adott feladatot (6.15. fejezet).
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6.4.1. ábra: PICkit 2 állapotjelentés

6.4.2. ábra: PICkit 2 csatlakozott a PC-hez
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6.5 Eszköz kiválasztása és beállítása

A PICkit 2 szoftvere lehetőséget nyújt kézi és automatikus eszközkiválasztásra. Amennyiben 
automatikus  eszközfelismerést  állítottunk  be  az  eszközkonfigurációs  panel  read  only79.  Kézi 
eszközkiválasztáshoz jelöljük be a  Programmer → Manual Device Select opciót! Válasszuk ki a 
Device Family menüben az alkalmazott eszköz családját.

Az eszközkonfigurációs ablakban kézi eszközkiválasztás esetén megadhatjuk a céláramkör 
pontos típusát. Amennyiben a kiválasztott és az érzékelt eszköz típusa nem egyezik meg, a PICkit 2 
erről a státuszablakban tájékoztat minket80 (6.5.2. ábra). A többi opció:

79 Csak olvasható
80 Ha a kiválasztott és az érzékelt eszköz nem ugyanazon család tagja, vagy nincs érzékelt eszköz, akkor a „No device  

detected.” üzenetet olvashatjuk.
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6.5.1. ábra: Eszköz konfiguráció

6.5.2. ábra: Hibás kézi eszközkiválasztás
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User IDs: Felhasználói azonosító.

Checksum: Ellenőrző összeg.

OSCCAL: Oszcillátor  kalibráció.  A  Tools  →  OSCCAL 
menüpont  segítségével  a  6.5.3. 
ábrán  látható  ablakban  tudjuk 
beállítani81 az OSCCAL regiszter 
értékét  azoknál  a  PIC 
mikorvezérlőknél,  ahol  erre  a 
gyártó lehetőséget ad. A szoftver 
figyelmeztet  minket,  hogy  ez  a 
beállítás  minden  adatot  töröl  a 
mikrovezérlőről.

BandGap: Tiltott sáv. A POR82 és a BOD83 feszültségszintek láthatóak itt.

Configuration: A kékkel kiemelt  Configuration szövegre kattintva előtűnik a konfigurációs 
szó szerkesztő ablaka (6.5.4.  ábra).  Itt  be tudjuk állítani  a beégetni 
kívánt  programtól  függetlenül  is  a  konfigurációt  (az  adott  bitekre 
kattintva  logikai  értékük vált).  A  Tools  → Display  Unimplemented  
Config Bits menüpontban beállíthatjuk, hogy az adott típusban nem 
létező biteket miként vegyük figyelembe (logikai 0, logikai 1, vagy a 
kódból kiolvasott).

A Configuration szöveg alatt a konfigurációs szótól függően megjelenhet a  Code Protect 
(kódvédelem engedélyezve), Data Protect (adatvédelem engedélyezve), vagy az All Protect (kód és 
adatvédelem  is  engedélyezve)  piros  felirat.  Ezen  beállításokat  a  konfigurációs  szó  módosítása 
nélkül a menüből is eltudjuk érni (Tools).

81 A szoftver lehetőséget nyújt autókalibrációra is, ekkor a gyári beállítás kerül alkalmazásra (a programmemória 
utolsó rekeszében található érték kerül az OSCCAL regiszterbe).

82 Power On Reset: Bekapcsolási reszet.
83 Brown Out Detect: Alacsony feszültség detektálása.
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6.5.4. ábra: Konfigurációs szó szerkesztő

6.5.3. ábra:
OSCCAL regiszter beállítása
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6.6 Tápfeszültség és reszet biztosítása a céláramkör számára

A Tools → Target VDD Source ablakban kiválaszthatjuk a céláramkör tápfeszültségének forrását:

Auto-Detect: A PICkit  2  méri  a  Target  VDD vonalát,  ha  a  céláramkörnek  nincs  saját 
tápforrása,  akkor  a  PICkit  2  biztosítja  a  szükséges  teljesítményt  a 
működéshez (max. ~ 80mA).

Force PICkit 2: A tápfeszültséget  a  PICkit  2  biztosítja.  A  szolgáltatott  feszültség 
értékét, be/kikapcsolását, valamint a reszetet a VDD ablakban (6.6.1. 
ábra) tudjuk beállítani.

Force Target: A céláramkör rendelkezik saját tápforrással. A tápforrás értékét a Check opció 
bepipálásával mérhetjük, a /MCLR opcióval a hardveres reszetfeltételt 
kapcsolhatjuk be/ki (6.6.2. ábra).

6.7 Programozás

A céláramkörrel történő műveletvégzésre a 6.7.1. ábrán látható funkciógombok szolgálnak.

Read: Céláramkör kiolvasása.

Write: Céláramkör írása.

Verify: Céláramkörben lévő információ összehasonlítása a memóriával.

Erase: Céláramkör törlése.

Blank Check: Céláramkör ellenőrzése, hogy üres-e.
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6.7.1. ábra: Programozó eszköztár

6.6.1. ábra:
Tápfeszültség szolgáltatás  

paramétereinek módosítása

6.6.2. ábra:
A céláramkör saját

tápforrásának mérése
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6.8 Program memória

A  Program Memory ablakban láthatjuk  a  beimportált,  vagy beolvasott  programmemória 
tartalmát. Szürke háttérrel a kezdőcímeket, míg fehér háttérrel a tartalmat jelöli a szoftver.

Az  Enabled opció  bejelölésével  a  Write parancsra  a  program  memória  tartalma  (is) 
letöltésre/kiolvasásra kerül a céláramkörbe/ből.

A legördülő menüből ki tudjuk választani, hogy milyen megjelenítési formát szeretnénk:

• Hex Only: a memóriatérkép csak a hexadecimális kódokat tartalmazza.

• Word ASCII84: a memóriatérkép a hexadecimális kód mellett megjeleníti a rekeszek 
tartalmát ASCII formátumban is – a szeparálás szavanként történik.

• Byte ASCII: a memóriatérkép a hexadecimális kód mellett megjeleníti a rekeszek 
tartalmát ASCII formátumban is – a szeparálás bájtonként történik.

A Source  mezőben  láthatjuk  a  programmemóriában  (és  az  EEPROM  adatmemóriában) 
megjelenített forrás típusát:

• None (Empty\Erased): Nincs, üres, vagy törölt. A programmemória minden rekesze  
FF értéket tartalmaz, a Write parancsnak ugyanaz lesz a hatása, 
mintha az Erase paranccsal törölnénk a céleszközt.

• Edited: Szerkesztett. A memóriarekeszek tartalmát kézi úton is 
állíthatjuk. Kettőt kattintva az adott rekeszen, annak tartalma 
módosítható.

• Read from …: A megnevezett eszközből kiolvasott kódot tartalmazza a 
programmemória.

• Fájlnév elérési úttal: A megadott fájl importálásának eredménye van a 

84 American Standard Code for Information Interchange: Amerikai szabvány az információ kódolására (részletekért l. 
http://hu.wikipedia.org/wiki/ASCII)
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6.8.1. ábra: Programmemória térkép

http://hu.wikipedia.org/wiki/ASCII
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programmemóriában.

6.9 EEPROM adatmemória

A 6.9.1. ábrán látható EEPROM adatmemória tartalmát a programmemóriához hasonlóan tudjuk 
kezelni.

A EEPROM Data ablakban láthatjuk a beimportált, vagy beolvasott EEPROM adatmemória 
tartalmát. Szürke háttérrel a kezdőcímeket, míg fehér háttérrel a tartalmat jelöli a szoftver.

Az  Enabled opció bejelölésével a  Write parancsra az EEPROM adatmemória tartalma (is) 
letöltésre/kiolvasásra kerül a céláramkörbe/ből.

A legördülő menüből ki tudjuk választani, hogy milyen megjelenítési formát szeretnénk:

• Hex Only: a memóriatérkép csak a hexadecimális kódokat tartalmazza.

• Word ASCII85: a memóriatérkép a hexadecimális kód mellett megjeleníti a rekeszek 
tartalmát ASCII formátumban is – a szeparálás szavanként történik.

• Byte ASCII: a memóriatérkép a hexadecimális kód mellett megjeleníti a rekeszek 
tartalmát ASCII formátumban is – a szeparálás bájtonként történik.

A programmemóriánál bemutatott Source mező az EEPROM adatmemória függvénye is.

6.10 Speciális programozás

Amennyiben  a  beimportált  fájlt  további  megerősítések  nélkül  le 
szeretnénk tölteni a céláramkörbe válasszuk az Auto Import Hex + 
Write  Device opciót.  A fájl  megnyitása  után  a  programletöltés 
automatikus.  A  normál  módba  való  visszatéréshez  klikkeljünk 
ismételten  az  említett  opciógombra.  A  folyamat  visszafelé  is 
lejátszható a Read Device + Export Hex File gomb segítségével. Az 
opció kiválasztásakor az olvasás azonnal megindul, majd megnyílik 
egy ablak, ahol megadhatjuk a kiexportált fájl nevét és helyét.

85 American Standard Code for Information Interchange: amerikai szabvány kód az információ cseréhez.
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6.9.1. ábra: EEPROM adatmemória térkép

6.10.1. ábra:
Speciális programozás
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6.11 A PICkit 2 által mért VDD feszültség kalibrálása86

A PICkit  2  tervezésénél  precíziós  alkatrészek  használata  helyett  szoftveres  kalibrációt 
alkalmaztak.  A VDD és  a  VPP feszültségeket  a  belső  A/D  átalakító  méri  egy  védőellenálláson 
keresztül. 

A Tools → Calibrate VDD & Set Unit ID... menüpont segítségével kalibráljuk be a PICkit 2 
által szolgáltatott VDD feszültséget!

A  következő  lépésekben  egy 
voltmérő  segítségével 
bekalibrálhatjuk a PICkit 2 által 
szolgáltatott  VDD feszültség 
értékét,  valamint  új  felhasználói 
azonosítót  adhatunk  a  PICkit2 
programozó  és  hibakereső 
eszközünknek87.  Elképzelhető, 
hogy  a  kalibráció  során  nem 
tudjuk  megfelelően  beállítani  a 
VDD feszültséget,  mert  az 
általunk használt USB port nem 
képes  biztosítani  a  szabványban 
előírt  potenciált.  Ebben  az 
esetben  próbálkozzunk  másik 
porttal.  A  kalibrációs  értéket  a 
PICkit 2 elmenti88, vagyis újbóli 
használatkor  (pl.  MPLAB)  is 
kalibrált állapotban lesz.

86 Az  itt  ismertetett  folyamat  valójában  felhasználói  beszabályozásnak  minősül  méréstechnikailag.  A kalibráció 
metrológiai definíciója ettől jelentősen eltér. Úgy döntöttem azonban, hogy mivel egyrészt az angol dokumentáció  
konzekvensen kalibrációnak nevezi a folyamatot, valamint a kalibráció a köznyelvben is ilyen – vagy ehhez nagyon 
hasonló  –  folyamatot  takar,  az  elnevezésen  jelen  dokumentációban  nem  változtatok.
Kalibráció: Állapotfelvétel a mérőeszköz mérési képességéről. Nem hatósági tevékenység. Az elfogadása bizalmon 
alapul. A hitelesítéssel szemben lehet részleges jellegű is. Elvégezheti maga a gyártó is, vagy 3. fél ún. kalibráló  
laboratórium – mely lehet akkreditált és nem akkreditált is (Nemzeti Akkreditáló Testület). A kalibrálás passzív 
tevékenység – azoknak a műveleteknek az összessége, amelyekkel (meghatározott feltételek mellett) megállapítható 
az összefüggés a mérőeszköz vagy a mérőrendszer értékmutatása, illetve a mérendő mennyiségnek mértékkel vagy 
anyagminta  által  megtestesített,  vagy  használati  etalonnal  megvalósított (helyes)  értéke  között.   
Beszabályozás: a  mérőeszköz  megváltoztatása  a  metrológiai  tulajdonságok  javítása  érdekében,  olyan  művelet,  
amellyel  a  mérőeszköz  használatra  kész  működési  állapotba  hozható.  A beszabályozás  lehet  automatikus,  fél-
automatikus és kézi. A folyamat során az eszköz megváltozik. A felhasználói beszabályozás olyan beszabályozás, 
ami a felhasználó rendelkezésére álló eszközökkel elvégezhető.

87 Ez  különösen  akkor  érdekes,  ha  több  PICkit  2-őt  szeretnénk  egy  operációs  rendszer  alatt  működtetni
(l. 6.15.fejezet).

88 A felhasználói azonosítóval egyetemben a belső EEPROM adatmemóriában tárolja.
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6.11.1. ábra:
PICkit 2 VDD kalibráció varázsló üdvözlőképernyő
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A kalibrációs  folyamat  megkezdéséhez  válasszuk  a  Next> opciót,  a  varázslóból  való 
kilépéshez a Cancel gombot.

A  kalibrálás  első  lépéseként  a 
PICkit  2  programozó  és 
hibakereső  eszközről  távolítsuk 
el  az  esetlegesen  csatlakoztatott 
céláramkört.  Egy  voltmérőt 
csatlakoztassunk a  6.11.2.  ábrán 
jelzett  VDD és  GND  lábakra.  A 
Next> gombra  kattintva  a 
PICkit2  4V-os  DC 
feszültségértéket  állít  elő  a  VDD 

lábra  a  GND-t  használva 
referenciapontként.  Vigyázat,  a 
Next> gomb megnyomásával az 
előző  kalibrációs  eredmény 
törlésre kerül.

A negyedik lépésben az általunk 
voltmérővel  mért 
feszültségértéket  adjuk  meg  a 
Volts  Measured mezőben.  A 
szoftverben  itt  sajnos  egy  hiba 
van  az  alapértelmezetten 
megadott 4.000 értékre a  6.11.3. 
ábrán  látható  hibaüzenetet 
kapjuk.  Bár  valóban  3 
tizedesjegy  pontosan  adhatjuk 
meg  (nem  kötelező,  csupán 
maximum  ennyi  lehet),  a 
tizedesjegyeket  az  egyesektől 
nem  ponttal,  hanem  vesszővel 
kell  kötelezően  elválasztani. A 
mért  érték  beírása  után 
kattintsunk a Calibrate gombra.

Amennyiben  a  kalibrálás 
eredményeként a 6.11.5. ábrán látható üzeneteket kaphjuk, az USB port nem képes megfelelő szintű 
feszültséget  szolgáltatni,  próbálkozzunk másik  porttal,  HUB-bal.  A PICkit  2  az  USB port  által 
szolgáltatott feszültséget egy védelmi feladatokat ellátó schottky diódán keresztül csatlakoztatja a 
céláramkörre.  Különösen  LAPTOP-ok esetén  szokott  előfordulni,  hogy az  USB port  feszültség 
sajnos  túlságosan  is  alacsony  a  megfelelő  kalibráció  elvégzéséhez.  Ha  a  CALIBRATION 
SUCCESFUL! üzenetet kaptuk a kalibráció sikerült.
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6.11.2. ábra:
PICkit 2 VDD kalibrációhoz szükséges lépések

6.11.3. ábra: PICkit 2 VDD kalibrálás
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Természetesen  a  kalibrációs  folyamat  eredménye  csak  az  adott  USB portra  vonatkozik, 
hiszen a PICkit 2 mindig ebből eredezteti a VDD target feszültséget.

Az  utolsó  lépésben  fakultatív 
módon  megadhatjuk  a  PICkit2 
felhasználói  azonosítóját.  A 
későbbiekben  több  PICkit2 
üzemeltetésekor  ezzel 
hivatkozhatunk rá. Maximum 14 
karakter  hosszú sztring  lehet  az 
azonosító  (bár  tartalmazhat 
különleges  szimbólumokat  –  pl. 
ékezetes karakter – ezek helyén a 
?  karakter  fog  megjelenni). 
Amennyiben  változtatni 
szeretnénk  az  eredetin  a  név 
beírása  után  kattintsunk  az 
Assign Unit ID gombra. A 6.11.7. 
ábrán  látható  feliratnak  kell 
megjelennie  az  ablak  alsó 
részében.  A  kalibráció 
befejezéséhez  kattintsunk  a 
Finished gombra. 

A folyamat befejezése után a PICkit2 operációs rendszere újraindul.
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6.11.6. ábra:
PICkit 2 felhasználói azonosító megadása

6.11.4. ábra:
Érvénytelen formátumú mért érték megadása

6.11.5. ábra:
Az eszköz nem kalibrálható, mert túl alacsony az USB port által szolgáltatott feszültség

6.11.7. ábra: Eszköz azonosító beállítva
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6.12 UART eszközként történő használat
A PICkit2  képes  a  PGC  és  PGD  lábakat  felhasználva  egy  virtuális  UART eszközként 

viselkedni.  Nullmodemes  (csak  az  RX,  TX,  GND lábakat  használjuk,  nincs  hardveres  címzés) 
kapcsolatot tudunk vele megvalósítani. Ez a funkció hasznos lehet, ha a céláramkörre írt soros porti  
kommunikációt szeretnénk letesztelni.

Nagyon  fontos  tisztázni,  hogy  a  PICkit  2  áramkört  közvetlenül89 NEM  SZABAD 
csatlakoztatni  egy  szabványos  RS-232C  szerint  kommunikáló  eszközhöz.  Anélkül  hogy 
részletesebben belemennénk a szabvány ismertetésébe az RS-232C kimondja,  hogy a vonalon a 
-3V-nál  kisebb  értékű  feszültségszint  MARK  (logikai  1),  míg  a  +3V-nál  nagyobb  értékű 
feszültségszint SPACE (logikai 0) értéknek felel meg. A PIC mikrovezérlő TTL jelszinttel dolgozik, 
5V → logikai 1, 0V → logikai 0. 

Válasszuk a Tools → UART Tool... menüpontot!

A 6.12.1. ábrát a fogadott és küldött információt megjelenítő fehér háttérrel ellátott ablakon 
kívül a következő részfelületekre tudjuk bontani:

• Hardveregység csatlakoztatása (6.12.2. ábra)

• Üzenetküldés (6.12.3. ábra)

• Funkciógombok (6.12.4. ábra)

• Baud Rate kiválasztása (6.12.5. ábra)

• Csatlakoztatás/leválasztás (6.12.6. ábra)

• Tápfeszültség (6.12.7. ábra)

• Rövid ismertető és súgó lehetőség (6.12.8. ábra)

• Üzemmód (6.12.9. ábra)

89 Létezik diszkrét elemekből, ill. integrált áramkörből (MAX232) felépített konverter.
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6.12.1. ábra: A PICkit2 UART eszközként való működése
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A 6.12.2. ábrán láthatjuk, hogy a PICkit 2 áramkört milyen 
módon   tudjuk  összekötni  a  tesztelni  kívánt  UART 
áramkörrel.  A normál  üzemmódban  PGD  funkciót  ellátó 
RB7-es láb a PICkit2 szempontjából nézve az RX (vétel), 
míg a PGC funkciót ellátó RB6-os láb TX (adás) láb lesz. A 
kommunikáció irányát az ábrán látható piros és zöld nyilak 
is jelzik. A tápfeszültségek összekötése nem feltétel, az RX, 
TX  lábak  mellett  a  GND-k  csatlakoztatása  a  minimális 
követelmény a kommunikáció megindításához. 

A  6.12.3.  ábrán  látható 
szövegmezőkbe  előre  rögzített 
üzeneteket írhatunk, amiket a Send 
gomb  megnyomásával  tudunk 
elküldeni  a  céláramkör  számára. 
Az  Append CR+LF (x0D + x0A) 
opció bejelölésével a szöveghez a 
program hozzáfűzi  a  kocsi  vissza 
(Carriage  Return)  és  a  soremelés 
(Line Feed) karaktereket.

A  Wrap Text opció  a  szöveg  tördelését  teszi  lehetővé,  amennyiben 
bejelöljük, akkor a szövegablak oldalirányban nem görgethető az ablak 
szélét elérve a szoftver sortörést alkalmaz. Az Echo On bepipálásának 
hatására  nem csak  a  vett,  hanem a  küldött  szöveg  is  megjelenik  a 
szövegablakban.  A  Log To File gomb megnyomásával  szövegfájlba 
tudjuk menteni a kommunikációt. A program zöld háttérrel  Logging 
Data jelzésre  változtatja  a  nyomógombot  –  így  jelezve,  hogy  a 
kommunikációról  jegyzőkönyv  készül.  Amennyiben  le  szeretnénk 
törölni a szövegablakot, nyomjuk meg a Clear Screen gombot. Az Exit  
UART Tool-ra kattintva kiléphetünk az UART módból.

A  6.12.5.  ábrán  látható  legördülő  menüből  ki  tudjuk  választani  a 
kommunikáció sebességét (Baud-Rate: az 1s alatt átvitt bitek száma). 
Amennyiben  nem  szabványos  sebességet  szeretnénk  beállítani 
válasszuk a Custom... lehetőséget, és adjuk meg a speciális Baud-Rate-
et. Amennyiben a tesztelni kívánt eszköz több sebességet is támogat, 
akkor a kiválasztásnál vegyük figyelembe a külső zavaró tényezőket, 
és a PICkit 2 erős zavarérzékenységét is.
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6.12.2. ábra:
PICkit 2 csatlakoztatása

6.12.3. ábra: Elküldhető szövegmezők

6.12.4. ábra:  
Funkciógombok

6.12.5. ábra: 
Baud-Rate  

kiválasztása



PICkit 2 V 2.61 programozószoftver bemutatása

A  kommunikációs  folyamat  megkezdéséhez  válasszuk  a  6.12.6.  ábrán  lévő  Connect, 
befejezéséhez a Disconnect gombot.

Amennyiben a  Tools → Target VDD Source menüpontban nem a céláramkört választottuk 
tápforrásként, lehetőségünk nyílik a PICkit2 felől megtáplálni a tesztelni kívánt UART áramkört. 
Jelöljük be a 6.12.7. ábrán látható opciót a VDD feszültség90 előállításához.

A 6.12.8. ábrán láthatjuk, hogy paritás nélküli 1 Stop bittel ellátott 8 bites adatcsomagokat 
tudunk küldeni. Ezen nincs lehetőségünk módosítani. Az újsor (kocsi vissza, soremelés) karakter az 
ASCII-ból ismert: 0D0A. A kék hátérrel ellátott kérdőjelre kattintva a 

A  6.12.9.  ábrán  láthatjuk  az  üzenetek  megjelenítésének  módját,  ami  lehet  ASCII,  vagy 
hexadecimális formátum.

90 Értékét a PICkit 2 főablakában a 6.6. fejezetben leírtak szerint tudjuk beállítani.
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6.12.7. ábra: VDD feszültség biztosítása a céláramkör számára

6.12.6. ábra: Csatlakoztatás/leválasztás

6.12.8. ábra: Általános leírás és súgó

6.12.9. ábra: Üzenetmegjelenítés módja



PICkit 2 V 2.61 programozószoftver bemutatása

6.13 Logikai analizátorként történő használat

A Tools → Logic Tool... menüpont segítségével léphetünk be a PICkit 2 logikai analizátor módjába.

A logikai analizátor felületét az alábbi részekre bonthatjuk:

• Tápfeszültség (6.13.2. ábra)

• Üzemmód (6.13.3. ábra)

• Megjelenítés (6.13.4. ábra)

• Közelítés (6.13.5. ábra)

• Funkciógombok (6.13.6. ábra)

• Hardvereszköz csatlakoztatása (6.13.7. ábra)

• Indítási feltételek (6.13.8. ábra)

• Adatgyűjtés (6.13.9. ábra)
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6.13.1. ábra: Logikai analizátor kezelőfelülete
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A PICkit 2 logikai analizátor üzemmódban is képes tápfeszültséggel91 ellátni a céláramkört. 
A bekapcsoláshoz jelöljük be a  6.13.2. ábrán látható opciót. Amennyiben a  Tools → Target VDD 
Source menüpontban a céláramkört jelöltük meg tápforrásként, akkor ez az opció nem választható.

A  6.13.3.  ábrán látható gombok segítségével  tudunk váltani  a  Logikai  I/O egység és  az 
analizátor üzemmód között.

A 6.13.4. ábrán láthatjuk a megjelenítő felületet, amelynek segítségével a mérést ki tudjuk 
értékelni. A csatornákat az angol channel rövidítésből Ch.1, Ch.2, Ch.3 névvel jelzi a szoftver. A bal 
felső sarokban láthatjuk az aktuális időalapot time/DIV (idő/osztás) kijelzéssel. Lehetőségünk van a 
képernyőn két elhelyezésére (Cursors opció bejelölése). Ezeket a program kék (X) ill. rózsaszín (Y) 
függőleges vonallal jelzi. A mozgatásukhoz használjuk a bal (X) ill. a jobb (Y) egérgombokat. A 
Cursors felirat mellett láthatjuk az aktuális pozíciójukat. Az abszolút távolságot mindig a piros színű 
függőleges vonallal jelölt indítási feltételhez képest mérjük. Mindemellett láthatjuk a köztük lévő 
relatív (Y-X) távolságot is. 

A  6.13.5.  ábrán  látható  Zoom ablakban  tudunk  a  megjelenítő 
képernyőn  látható  jelalakoktól  távolítani  (0,5x),  vagy  rájuk 
közelíteni (1x; 2x; 4x).

91 Értékét a PICkit 2 főablakában a 6.6. fejezetben leírtak szerint tudjuk beállítani.
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6.13.2. ábra: Tápfeszültség be- és kikapcsolása

6.13.3. ábra: Üzemmód kiválasztása

6.13.4. ábra: Logikai analizátor megjelenítő felülete

6.13.5. ábra: Közelítés
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A  6.13.6.  ábrán  látható  funkciógombok  segítségével  előhívhatjuk  a  súgót  (Help), 
elmenthetjük bitmap formátumban az elkészített felvételt (Save), vagy visszatérhetünk a PICkit 2 
normál üzemmódjába (Exit Logic Tool).

A 6.13.7. ábrán láthatjuk, hogy a PICkit 2 mely lábait, 
milyen  csatornaszámoknak  feleltethetjük  meg. 
Vegyük figyelembe, hogy az 1-es és a 2-es csatorna 
(eredetileg  PGC,  PGD)  a  PICkit  2-ben  található 
4,7kΩ-os ellenállásokon keresztül földre van kötve. A 
GND és VDD lábakat92 kötelezően csatlakoztatnunk 
kell  az  áramkörhöz.  A tápfeszültség  értékét,  és  azt, 
hogy melyik áramköri egység biztosítsa azt a PICkit 2 
főablakában tudjuk beállítani (6.6. fejezet).

A  Trigger ablakban  be  tudjuk  állítani,  hogy  a  PICkit  2 
milyen feltétel hatására kezdje meg az adatgyűjtést.

Feltételek:

• *: Don't Care – nem meghatározott (bármi)

• 1: Logic High – magas szint

• 0: Logic Low – alacsony szint

• /: Rising Edge – felfutó él

• \: Falling Edge – lefutó él

Az egyes csatornáknál beállított feltételek logikai ÉS kapcsolatban állnak egymással. Vagyis 
a  6.13.8.  ábrán látható beállítás  azt  jelenti,  hogy az egyes  csatorna logikai  1,  a  kettes  csatorna 
logikai nulla állása mellett akkor kezdődik meg az adatgyűjtés, ha a hármas csatornán felfutó él  
keletkezik. Amennyiben valamelyik csatornát ki szeretnénk szedni a feltétellistából, akkor esetében 
állítsuk be a * - Don't Care lehetőséget!

92 Ennél a folyamatnál különösen ügyeljünk arra, hogy a PICkit 2, vagy a céláramkör biztosítja a tápfeszültséget, ill.  
hogy annak mekkora értéknek kell lennie.
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6.13.6. ábra: Funkciógombok

6.13.7. ábra:
A hardveregység csatlakoztatása

6.13.8. ábra: Indítási  
feltétel



PICkit 2 V 2.61 programozószoftver bemutatása

Az  Acquisition ablakban  tudjuk  beállítani  a 
mintavételezési frekvenciát, valamint a triggerelés 
módját.  A  RUN gombbal  ebből  az  ablakból 
indítható az adatgyűjtés folyamata. A Sample Rate 
mezőben  a  legördülő  menüből  válasszuk  ki  a 
mintavételezési frekvenciát! A szoftver megjegyzi, 
hogy  a  mintavételezési  frekvencia  fele  feletti 
jeleknél kialakulhat az aliasing jelenség93.

A triggerelési módok egy logikai analizátornál a következők lehetnek:

Utótriggerelés Az  adatgyűjtés  az  indítási  feltétel  megtörténtekor  kezdődik.  A  leggyakrabban 
használt  indítási  forma,  segítségével  megtudhatjuk, 
hogy  egy  előre  meghatározott  esemény  milyen  más 
eseményeket von maga után (6.13.10. ábra).

Utótriggerelés késleltetéssel: Az adatgyűjtés az indítási feltétel megtörténte után egy előre beállított 

93 Shannon  törvénye  szerint  periodikus  jelek  esetén  minimum  kétszeresnek  kell  lennie  (Nyquist-küszöb)  a 
mintavételezési frekvenciának a mintavételezett jelhez viszonyítva. Amennyiben ez a feltétel nem teljesül kialakul az 
ún. aliasing jelenség (átlapolódás), vagyis olyan jelek is megjelennek a mintavételezési folyamat során, amelyek az 
eredeti spektrumban nem szerepeltek.
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6.13.9. ábra: Adatgyűjtés opciói

6.13.10. ábra: Utótriggerelés szemléltetése
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S
Mintavétel

Trigger esemény Memória megtelt
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Mintavétel

Trigger esemény
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késleltetéssel valósul meg (6.13.11. ábra).

Előtriggerelés:Az adatgyűjtés a feltétel előtt folyamatosan zajlik, és a feltétel teljesülésekor áll le. 
Nagyon hasznos beállítási lehetőség. Amennyiben egy 
adott  hiba  bekövetkezett,  megtudhatjuk,  hogy milyen 
események vezettek el ideáig (6.13.12. ábra).

Előtriggerelés késleltetéssel: Az  adatgyűjtés  a  feltétel  előtt  folyamatosan  zajlik,  és  a  feltétel 
teljesülése  után  egy  előre  beállított  késleltetéssel 
később áll le.

Középtriggerelés: Az adatgyűjtés a feltétel előtt és után is zajlik, úgy, hogy a triggeresemény 
álljon  a  tárolható  események  középpontjában. 
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6.13.12. ábra: Előtriggerelési mód szemléltetése
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6.13.11. ábra: Utótriggerelés késleltetéssel
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Alapvetően az elő-  és utótriggerelés  jó tulajdonságait 
ötvözi. Lehetőségünk van egy esemény előzményeit, és 
következményeit  is  egy  felvételen  megtekinteni 
(6.13.13. ábra). 

Középtriggerelés késleltetéssel: A  középtriggerelésnél  leírtak  szerint  zajlik  a  folyamat,  de 
beállíthatunk  egy  késleltetést  ezzel  eltolva  a 
középpontot az esemény halmaz időbeli vége felé.

A triggerelési módok közül a PICkit 2 az alábbi lehetőségeket támogatja:

• Utótriggerelés – Start of Data

• Utótriggerelés késleltetéssel – Delay Windows (1 ablak 1000 mintányi késleltetést jelent)

• Előtriggerelés – End of Data

• Középtriggerelés – Center of Data

A logikai  analizátor  üzemeltetése  mellett  lehetőségünk  van  egy  egyszerű  I/O  egység 
működtetésére.  Az  átváltást  a  különböző  üzemmódok  között  a  6.13.3.  ábrán  látható  gombok 
segítségével tudjuk megvalósítani.
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6.13.13. ábra: Középtriggerelés bemutatása
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Kattintsunk  az  Enable  IO gombra  a  logikai  egység  üzemeltetésének  megkezdéséhez.  A 
működéshez szükségünk van tápfeszültségre, ennek hiányában a 6.13.15. ábrán látható hibaüzenetet 
kapjuk.

Amennyiben a céláramkör nem rendelkezik saját tápforrással jelöljük be a  VDD On opciót, 
így  a  PICkit  2  látja  el  tápfeszültséggel  az  áramkört.  Figyelem,  az  áramkörnek  megfelelő 
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6.13.14. ábra: Logikai analizátor csatornáinak konfigurálása

6.13.15. ábra: Tápfeszültség hiba



PICkit 2 V 2.61 programozószoftver bemutatása

feszültségértéket a PICkit 2 főablakában tudjuk beállítani (6.6. fejezet).

A Help gombra kattintva megnyílik a Logic Tool User Guide – ami segítséget nyújt a logikai 
analizátor és az I/O egység használatához.
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6.14 Firmware update
Tartsuk lenyomva a PICkit 2 hardveregységen lévő nyomógombot, és így csatlakoztassuk a 

számítógéphez.  A piros  Busy jelzésű LED-nek villognia kell,  ezzel  jelezve  hogy a PICkit  2-őt 
bootloader módban indítottuk el. A PICkit 2 szoftverének indításakor a 6.14.1. ábrán üzenetet kell 
kapnunk94. 

A Tools → Download Pickit 2 Operating System menüpontot választva adjuk meg a letölteni 
kívánt  firmware  helyét.  Amennyiben  a  fájl  neve  nem  egyezik  meg  a  szabványos  Pickit2  OS 
formátummal válasszuk a keresés során a minden fájltípus mutatását (All Files) .

A kiválasztás után a 6.14.2. ábrán látható jelentéseknek kell megjelenniük a státuszablakban.

Lehetőségünk van normál módban is firmware-t frissíteni a  Tools → Download Pickit  2  
Operating  System menüpont  segítségével95,  ill.  automatikusan  frissíthetünk  az  MPLAB  IDE 
rendszerrel is.

A  6.14.3.  ábrán  látható hibaüzenetet  kapva a  Tools  → Check Communication menüpont 
segítségével próbáljuk újra csatlakoztatni a PICkit 2 áramkört és ismételjük meg a folyamatot.

94 Amennyiben  véletlenül  indítottuk  bootloader  módban  a  PICkit  2-őt  válasszuk  le  és  csatlakoztassuk  újra  a 
nyomógomb nyomva tartása nélkül.

95 Ilyenkor a PICkit 2 0-át ír be a 0x7FFE címre, majd reszetel. A firmware induláskor ellenőrzi, hogy a hardveren 
található gomb lenyomva volt-e, vagy a 7FFE címen 0 van e. Bármely feltétel igaz volta magával vonzza a bootloader 
módba történő belépést.
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6.14.1. ábra: Bootloader módban történő indítás

6.14.2. ábra: Firmware frissítés állapotok

1 2

3 4

6.14.3. ábra: Hiba történt a letöltés közben
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6.15 Több PICkit2 használata egy platform alatt

Amennyiben  több  PICkit  2  áramkört  szeretnénk 
használni  egy operációs  rendszer  alatt,  akkor  első 
lépésként a 6.11. fejezetben látható módon lássuk el 
őket különböző azonosítókkal. Csatlakoztatva két, 
vagy több eszközt a programozószoftver indításakor 
a  6.15.1.  ábrán  látható  választás  előtt  állunk. 
Válasszuk  ki  a  használni  kívánt  eszközt,  majd 
kattintsunk a Select gombra.

Ha  a  programozási  folyamat  során  bármikor  váltani  szeretnénk  az  eszközök  között, 
válasszuk a  Tools → Check Communication menüpontot, és a  6.15.1. ábrán felbukkanó ablakban 
adjuk meg az aktuális PICkit 2 felhasználói azonosítóját.

Az  MPLAB IDE rendszerben  is  használhatunk  több PICkit  2  egységet,  azonban  ott  az 
átváltások során mindig programozóeszközt kell  váltanunk (Programmer → Select Programmer 
menüpontban96)

96 Az átváltáshoz szükséges ablak előhívásához válasszuk a None, majd a PICkit2 opciókat.
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6.15.1. ábra:
Több PICkit 2 csatlakoztatása
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7 Melléklet

7.1 PICkit2 debugger és az MPLAB IDE fejlesztőkörnyezet  
együttműködése

Az MPLAB IDE programról – az interneten történő rövid keresés után – részletes angol, és 
magyar leírást találunk, ezért itt csak a legfontosabb funkciókra térünk ki a PICkit 2 kapcsán.

7.1.1 Programozóként történő használat

Gyakran  előfordul,  hogy csupán  a  program beégetésére  van  szükségünk,  és  a  PICkit  2 
nyomkövető  funkcióját  nem szeretnénk  kihasználni  –  ebben  az  esetben  használhatjuk  a  hozzá 
tartozó szoftvert, amit már a korábbiakban bemutattunk, vagy az MPLAB IDE fejlesztőkörnyezetet.

Válasszuk  ki  programozóként97 a  PICkit  2  hardveregységet  –  majd  a  Programmer  → 
Settings98 menüpont segítségével állítsuk be a PICkit 2 tulajdonságait.

97 Programmer → Select Programmer → PICkit 2
98 Programozó → Beállítások
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7.1.1.1. ábra: PICkit 2 konfigurálása,  
beállítások fül

http://plc.mechatronika.hu/mplab/mplab_v810_leir.pdf
http://www.microchip.com/Microchip.WWW.SecureSoftwareList/secsoftwaredownload.aspx?device=en019469&lang=en&ReturnURL=http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&dDocName=en019469&part=SW007002#
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Automatically...: A bejelölt funkciók automatikus végrehajtása.

Connect on startup: Csatlakoztatás bekapcsoláskor.

Program after a successful build: Sikeres  fordítás  esetén  programozás  (a  céleszközbe  történő 
égetés).

Run after a successful program: Sikeres programozás után futtatás.

Output to debug file: Kimeneti debug fájl generálása a program futtatásáról.

3-State on „Release from Reset”: A  Release from Reset opció hatására az  MCLR  lábat  tri-
state állapotba húzza.

Use target power always: Mindig a céláramkör adja a tápfeszültséget.

Use Prog Exec if available: 16 bites vezérlők (24-es, ill. dsPIC-ek) esetén alkalmazható beállítás, a 
Programming Executive  (PE) mód lerövidíti  a  programozási 
időt.

Preserve device EEPROM: Az eszköz EEPROM memóriatartalmát megőrzi.

Set VDD Voltage to: VDD tápfeszültség beállítása (alapértelmezetten a  Configure →  Settings-ben 
megadott típus határozza meg).
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7.1.1.2. ábra: PICkit 2 konfigurálása,  
veszélyek fül
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A  7.1.1.2.  ábrán  látható ablakban jelöljük be azokat  a  veszélyeket,  amelyekről  értesítést 
kívánunk kapni, ill. a feleslegeseket pipáljuk ki. Mindemellett lehetőségünk van az összes veszély 
együttes bejelölésére (Check All), valamint elhagyására (Uncheck All).

(Deprecated99) PKWarn0001: There is a newer version of the PICkit 2 Operating System.

(Deprecated) PKWarn0002: The Operating System on this PICkit 2 is newer than the one intended 
for use with the current version of MPLAB IDE.

PKWarn0003:Unexpected  device  ID: Please  verify  that  a  %s  is  correctly  installed  in  the 
application. (Expexted ID= 0x%X, ID Read = 0x%X).

PKWarn0004:Protect  bit  (%s:  %s)  is  enabled.  PICkit  2  will  not  enter  debug  mode  in  this 
configuration. Do you wish to disable this settings?

PKWarn0005:Watchdog timer is currently enabled. PICkit 2 cannot be used while the watchdog 
timer is active. Disable watchdog timer?

PKWarn0006:The  local  copy  of  program  memory  has  been  changed  since  the  last  program 
operation.  Should  PICkit  2  program  the  target  (fix)  before 
proceeding?

PKWarn0007:The target will be programmed with the MCLR pin disabled. PICkit 2 cannot debug 
the target in the state. Would you like to enable the MCLR pin?

PKWarn0008:The target will be programmed with LVP enabled. PICkit 2 cannot debug the target 
in the state. Would you like to disable LVP?

PKWarn0009:The target will be programmed with Power Up Timer enabled. PICkit 2 cannot debug 
the target in the state. Would you like to disable the PUT?

PKWarn0010:MPLAB IDE is  about  to  download a  new OS to  the  PICkit2.  Please  disconnect 
PICkit 2 from any device or target board before continuing. If 
more  than  1  PICkit  2  unit  is  connected  to  the  PC  select 
„Cancel”, remove all units except the o:

PKWarn0001:A szoftver a jelenleginél újabb verziójú firmware-t tartalmaz. A frissítés indokolt.

99 Azon veszélyforrások mellett, melyeket nem jelöltük meg megtaláljuk a deprecated-érvénytelenített jelzőt.
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PKWarn0002:A PICkit2 firmware-e újabb, mint a jelenleg használatos MPLAB IDE rendszer.

PKWarn0003:Váratlan  eszközazonosító:  kérlek  ellenőrizd,  hogy  a  %s  helyes-e  az  adott 
alkalmazásban! (Várt azonosító: 0x%X, Olvasott azonosító: 0x
%X)

PKWarn0004:Védelmi (kód, adat, stb.) bit engedélyezve. A PICkit2 nem tud belépni a hibakereső 
módba az adott konfigurációban. Kikapcsolod a védelmet?

PKWarn0005:A Watch Dog Timer jelenleg engedélyezett. A PICkit2 nem alkalmazható ha a WDT 
aktív! Kikapcsolod?

PKWarn0006:A  programmemóriában  változás  történt  a  legutóbbi  művelet  végrehajtása  óta. 
Beégessük  az  új  információt  a  céláramkörbe,  mielőtt  az 
aktuális műveletet végrehajtjuk?

PKWarn0007:A céláramkörben az  MCLR  láb ki  van kapcsolva (bemenetként  konfigurálva). 
Ilyen beállítás mellett a PICkit2 nem tud belépni a hibakereső 
módba! Engedélyezi az MCLR  funkciót?

PKWarn0008:Alacsony  feszültségű  programozási  mód  engedélyezve.  A  PICkit2  így  nem 
használható hibakeresőként. Kikapcsolod az LVP-t?

PKWarn0009:A céláramkörben a PWRT engedélyezve van. Ilyen beállítás mellett a PICkit2 nem 
tud belépni a hibakereső módba. Kikapcsolod a bekapcsolási 
reszet időzítőjét?

PKWarn0010:Az MPLAB IDE új operációs rendszert tölt le a PICkit2-be. Kérlek, minden eszközt, 
céláramkört  válassz  le  a  PICkit2-ről.  Amennyiben  egyszerre 
több PICkit2-őt használsz, válaszd a Mégse opciót, és válaszd 
le az összes többi egységet a PC-ről.

Tegyük  aktívvá  a  beégetni  kívánt  forrást100,  majd  válasszuk  ki  a  Configure  →  Select  
Device...101 menüpont  segítségével  a  mikrovezérlőnket  –  amennyiben  szükséges  állítsuk  be  a 
Configure  →  Configuration  Bits... menüpontban  a  konfigurációs  biteket.  A  programozást  a 
Programmer102 (7.1.1.1.  fejezet)  menüpont,  ill.  a  Programmer eszköztár  (7.1.1.2.  fejezet) 

100Ha csak a hex fájl  áll rendelkezésünkre,  akkor válasszuk a  Project → Set Active Project menüpontnál  a  None 
(Quickbuild) opciót és importáljuk be a gépi kódú fájlt (File → Import...). Ha projekt rendszerben dolgozunk  a 
Project → Set Active Project menüpontnál válasszuk ki a projektünket (szükség esetén nyissuk meg) majd fordítsuk 
le a forrásfájlt (Project → Build).

101Konfiguráció → Eszköz kiválasztás
102 Programozó
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segítségével tudjuk elvégezni.

7.1.1.1 Programozó menü

Select Programmer: Programozó hardveregység kiválasztása.

Program: Az  aktuális  forrás  céleszközbe  történő  beégetése. 
(Program  memória,  EEPROM  adatmemória,  konfigurációs 
bitek, azonosító.)

Read: Targetből való kiolvasás. (Program memória, EEPROM 
adatmemória, konfigurációs bitek, azonosító.)

Verify: Ellenőrzés – az aktív forrás és a céleszközben történő 
program  összehasonlítása.  (Program  memória,  EEPROM 
adatmemória, konfigurációs bitek, azonosító.)

Erase: Céleszköz  törlése.  (Program  memória,  EEPROM 
adatmemória, konfigurációs bitek, azonosító.)

Blank Check: Ellenőrzi, hogy a céleszköz üres-e.

Read  EEDATA: EEPROM  adatmemória  kiolvasása  a 
mikrovezérlőből.

Connect: Csatlakozás a PICkit 2 hardveregységhez.

Download OS: Az operációs rendszer letöltése.

Release from Reset: A reszetfeltétel megszüntetése103.

Hold in Reset: Reszetben tartás104.

Set Vdd On: Target_VDD bekapcsolása (csak akkor aktív, ha a 
PICkit2 adja a tápfeszültséget).

Set Vdd Off: Target_VDD kikapcsolása (csak akkor aktív, ha a 
PICkit2 adja a tápfeszültséget).

Settings: Beállítások (7.1.1. fejezet)

7.1.1.2 Programozó eszköztár

103 MCLR láb nagyimpedanciás (Hi-Z) állapotba vitele.
104 MCLR láb nullában tartása.
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Az eszköztár105 funkciói balról jobbra106

Program the target device: Az aktuális forrás beégetése a céleszközbe.

Read target device memories: A mikrovezérlő memóriájának kiolvasása.

Read the target EEDATA memory: EEPROM adatmemória kiolvasása a mikrovezérlőből.

Verify the contents of the target device: Az  eszköz  tartalma  és  az  aktuális  forrás 
összehasonlítása.

Erase the target device memories: A céleszköz memóriájának törlése.

Verify that target memories are erased: A céleszköz törölt voltának ellenőrzése.

7.1.2 Debuggerként történő használat

7.1.2.1 Korlátozások a hibakeresés során

A PICkit2  egy debugger  és  nem emulátor,  így –  az  anyagi  előnyök mellett  –  meg kell 
barátkoznunk néhány megkötéssel a használata során.

Az  MCLR ,  RB6,  RB7 lábak  nem  használhatóak  általános  I/O-ként,  vagy  a  rájuk 
multiplexált  perifériaként,  mert  fent  vannak  tartva  a  hibakeresés  során  történő  kommunikációs 
eljárás számára.

A töréspontok  komplexitása  és  száma  korlátozott  (az  adott  típushoz  tartozó  értéket  a 
Debugger → Breakpoints... menüpont alatt az Active Breakpoint Limit mezőben találjuk).

A  hibakereső  üzemmódban  történő  használathoz  tanulmányozzuk  a 
http://plc.mechatronika.hu weboldalon található MPLAB leírást!

105 A View → Toolbars → PICkit 2 toolbar opció segítségével tudjuk be- és kikapcsolni az eszköztárat.
106 Az MPLAB IDE fejlesztőkörnyezet alkalmazza az ún. mouseover lehetőséget, vagyis ha az egeret az ikon fölé 

visszük, látszódik a funkciója.
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7.2 ICSP

7.2.1 Az ICSP fogalmának tisztázása

Az  ICSP  mozaikszó  jelentése:  In  Circuit  Serial  Program  –  áramkörben  történő  soros 
programozás.  A helyben történő programozás  (In-System Programming – ISP) nem újdonság a 
programozható  alkatrészgyártók  körében.  Legismertebb  képviselője  a  Joint  Test  Action  Group 
(JTAG107)  protokoll,  melyet  az  elektronikus  eszközök  peremfigyelésére  fejlesztettek  ki.  Az 
áramkörben történő programozás előnyei:

• Csökkenő költségek (nem kell külön foglalat a programozóban, ill. az áramkörben)

• Csökkenő programozási idő (nem kell az integrált áramkört kiszedegetni)

• Kényelmesebb fejlesztés (a különböző frissítésekhez nem kell az áramkört megbontani)

• Csökkenő mechanikai igénybevétel

• Peremfigyelés (A Boundary Scan technológia segítségével 4, esetleg 5 vezetéken keresztül 
tudjuk tesztelni az elektronikus eszközöket, ill. felprogramozni az erre alkalmas elemeket.)

• Nincs más lehetőség108

A Microchip cég a mikrovezérlőihez kifejlesztett ISP technikát ICSP-nek nevezi.

107 Később az  IEEE 1149.1 nemzetközi  szabványként  fogadták el  Standard Test  Access  Port  and Boundary-Scan 
Architecture néven

108 Képzeljünk el  egy 256 lábú BGA tokozású integrált  áramkört  amelyet  többször is  fel  kell  programoznunk ill. 
tesztelnünk a fejlesztés során.
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7.2.2 Az ICSP működése

Az ICSP technika során 5 kivezetést használunk a mikrovezérlő felprogramozására:

• VDD: A mikrovezérlő pozitív tápfeszültség kivezetése.

• VSS: A mikrovezérlő földpontja (GND).

• MCLR : Master  CleaR láb,  amellyel  a  hardveres  reszet  mellett  speciális 
programozómódba tudjuk juttatni a mikrovezérlőt (VPP láb).

• PGC: ProGramming Clock láb (RB6), órajelvonal (ICSPCLK).

• PGD: ProGramming Data (RB7), adatvonal (ICSPDAT).

Az ICSP során először ki kell választanunk, hogy az égető áramkör (HOST), vagy pedig a 
céláramkör (TARGET) biztosítsa e a tápellátást. Amennyiben a TARGET adja a VDD feszültséget, 
akkor  aktív  égető109 esetén nincs  szükség a  VDD vonalak összekötésére.  Az MCLR láb magas 
szintbe billentése után kezdődik meg a kommunikáció a kétirányú PGD lábon, míg a PGC lábon a 
HOST  biztosítja  a  kommunikációhoz  szükséges  órajelet  (7.2.2.1.  ábra).  Az  égetőáramkörtől 
függően a PGD és PGC lábakon történő kommunikáció sebessége állítható (pl. PICkit 2), ill. ezen 
lábak tartalmaznak puffert (pl. PICkit 3) a nagyobb távolságra történő kommunikáció miatt.

109 Az  égető  áramkörök általában  rendelkeznek saját  tápfeszültséggel,  bár  elképzelhető  olyan  kivitel  is,  amely a  
tápforrás szempontjából a céláramkörre van utalva.
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Az idődiagram alapján  végig  tudjuk követni  a  kommunikációs  eljárást.  Az MCLR láb 
magas szintbe billenése RESET-et okoz, és a mikrovezérlő ICSP módba kerül. Az RB6 lábon kapott 
órajel  alapján110 értelmezi  az  RB7 lábon  kapott  utasítást.  A vizsgált  diagram  a  18-as  családra 
vonatkozik,  ebben az  esetben a  programozás  során  a  TBLRD (memória olvasás)  és  a  TBLWT 
(memória  írás)  utasításokat  használjuk.  Az  egyes  családok,  és  speciális  típusokra  vonatkozó 
specifikáció  jelentősen  eltérhet111,  itt  csupán  az  elvet  kívántuk  megvilágítani.  Részletesebb 
információért l. ICSP User Guide.

Az ICSP-re előre fel kell készítenünk áramkörünket. A Microchip a  7.2.2.2. ábrán látható 
elrendezést ajánlja. Ennek egy kicsit módosított verziója látható a 7.2.2.3. ábrán

Vizsgáljuk meg először a gyártó által ajánlott kapcsolást! Az MCLR  lábat egy RC tag 
húzza fel tápra a stabil működés biztosítása érdekében112 A 7.2.2.2. ábrán látható dióda113 az ICSP 
csatlakozó felől érkező magasabb feszültség114 leválasztására szolgál. A VDD tápfeszültségre felhúzó 
ellenállást rövidzárral115 helyettesítsük! A GND-ket összekötjük. Az RB6 és RB7 lábakon elhelyezett 
leválasztó áramkör a perifériától függően kerül kiválasztásra. Ezeken a lábakon a kommunikáció 
nagy  sebességű,  ezért  az  egyes  égetőáramkörök  általában  nem  tolerálják  a  nagy  értékű 
kapacitásokat.  Amennyiben nincs  a  lábakon nagykapacitású eszköz,  és  nem okoz problémát  ha 
kívülről táplálást kap az adott periféria, akkor az izolációs áramköri rész elhagyható.

110 Minden lefutó élnél vesz mintát, elvileg ez a bitközép.
111 Pl. régebbi mikrovezérlők (PIC16F84) még 13V-ot igényeltek az MCLR lábon programozói módba történő 

lépéskor..
112 A használt PIC típusának megfelelő adatlapon a RESET szekcióban  láthatunk külső áramkört a POR (Power On 

Reset – bekapcsolási reszet) biztosítására. Ezt minimálisan egy RC taggal érhetjük el, a katalógusajánlás tartalmaz 
még egy soros védőellenállást (1kΩ), valamint egy a kondenzátor kisütését segítő diódát. Az RC tag elemeinek 
értékét katalógus alapján határozhatjuk meg R általában kisebb mint 40kΩ (tipikus értéke 10kΩ), míg a kondenzátor 
értékét a VDD minimum felfutási ideje alapján számolhatjuk.

113 A nagyobb zajtartalék érdekében alkalmazható Schottky dióda is.
114 A PIC típusától függően az ICSP módba történő átkapcsolás az MCLR lábon 3,3V-ot, 5V-ot, vagy 13V-ot igényel.
115 Gondoljunk bele, hogy pl. 100mA befolyó áram esetén egy 10Ω-os ellenálláson 1V feszültségesés keletkezne.
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Néhány példa az RB6, RB7 lábakon lévő eszközre:

LED, LED kijelző, LCD kijelző: amennyiben nem zavar minket,  hogy a programozás során a 
LED,  vagy LED  kijelző  villog,  nem kell  leválasztanunk  az 
ICSP csatlakozóról.

Nyomógomb, kapcsoló: ha  nincs  a  csak  védelmi  célokat  ellátó  lehúzó  ellenállás,  akkor  – 
szerencsétlen  kapcsolóállásban  –  az  adatvonalon  jövő 
jelfolyamot  egy  az  egyben  rövidre  zárhatjuk,  ezért 
mindenképpen szükséges a leválasztás.

Tranzisztoros meghajtó: egyes tranzisztorok – különösen igaz ez a FET-ekre116 – nagy bemeneti 
kapacitással  rendelkeznek.  A  kapcsolás  tervezésénél 
figyelemmel  kell  lennünk  arra,  hogy  az  RB6,  RB7 lábakon 
normál  működés  esetén  fellépő  jeleknél  programozás  során 
nagyságrendekkel  nagyobb  frekvenciájú  jeleknek  is 
érvényesülniük kell.

Statikus vonal: a  lassan  változó  vonalakat  gyakran  védjük  szűrőkondenzátorokkal  a 
nagyfrekvenciás zajok ellen, ill. az energiakiesés (áramlökés) 
kiküszöbölésének érdekében pufferkondenzátorokkal tartjuk a 
megfelelő  feszültségértéket.  Ezek  a  kondenzátorok 
programozás során károsak, ezért az ilyen vonalakat is le kell 
választanunk az égetőről.

Itt jegyeznénk meg, hogy nagyfrekvencián az ezekre a lábakra kötött alkatrészeket különös gonddal 
kell megválasztanunk. Nem használhatunk pl. szupresszor diódát nagy kapacitása miatt.

A leválasztás történhet jumper, kapcsoló, elektronikus kapcsoló, vagy optocsatoló segítségével.

116 Jellemző példa: IRF530 típusú FET-nél a CGS = 640pF.
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7.2.2.3. ábra: Lehetséges ICSP elrendezés
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Feltételezzük, hogy az égetőn nincsen kialakítva védelem! Ebben az esetben a csatlakozó 
fordítva való ráhelyezése, vagy rossz lábkiosztása alkalmazása tönkreteheti nemcsak a céláramkört, 
de a programozót is. A 7.2.2.3. ábra az esetleges meghibásodásból, rossz alkalmazásból eredő hibák 
minimalizálását teszi lehetővé.  Az R, C, D1 elemek a gyári  elrendezésből megismert szerepeket 
látják  el.  Az  F1,  F2,  F3,  F4

117 elemekkel  áramkorlátozást,  míg  a  D2,  D3,  D4,  D5
118 diódákkal 

túlfeszültségvédelmet valósítunk meg. A biztosítékokkal sorba kötve használhatunk védőellenállást 
is – ez alól kivételt képez a tápfeszültség vonala, hiszen itt az ellenálláson ha a programozó táplálja 
az áramkört túl nagy feszültség esne. Ezek tipikus értéke: 270Ω. 

A különböző égetőáramkörök ICSP lábkiosztása nem feltétlenül ugyanaz.  Használat  előtt 
mindig  ellenőrizzük,  hogy  a  céláramkörön  kivezetett  ICSP csatlakozó  és  az  általunk  használt 
programozó  lábkiosztása  megegyezik-e  –  kell-e  esetleg  valamilyen  átalakítót  alkalmaznunk.  A 
lábak felcserélése a céláramkör, ill. adott esetben az égető tönkremeneteléhez vezethet.

117 Ajánlott FF jelzésű ún. félvezetővédő biztosíték alkalmazása.
118 A Zener diódák feszültségértéke – a PIC típusától függően – 3V3, 5V, vagy az MCLR lábon 15V.
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7.3 PICkit 2 klón építése

Az áramkör megépítését csupán olyan embereknek tudom ajánlani, akiknek örömet okoz az 
építés, és a tudat, hogy egy általunk tervezett/készített áramköri egységet használunk fel munkánk, 
vagy hobbink során. Anyagilag nem éri meg ezt az áramkört elkészíteni119 abban az esetben, ha az 
eredeti  PICkit  2  funkcióira  van  szükségünk.  Mindemellett  a  klónáramkör  a  PGD,  PGC  lábak 
leválasztása,  a nagyobb áramigény kielégítése és a kialakított  hardveres védelem miatt  nagyobb 
tudású áramkörnek számít az eredeti konfigurációnél. 

7.3.1 Hardver felépítés

A Microchip PICkit 2® áramkörhöz képest több változtatás is történt, amelyeket az alábbi 
fejezetekben ismertetünk.

7.3.1.1 Alkatrészek kiválasztása

Az alkatrészek kiválasztása során alkalmazott fő szempontok:

• Kizárólag120 THT121 alkatrészek alkalmazása
• Könnyen beszerezhető, és helyettesíthető típusok
• Ismert és gyakran használt tokozás

A  fentieket  figyelembe  véve  a  bipoláris  tranzisztorokat  BC337,  és  BC327  típusokra 
cseréltük122. A booster FET-et a népszerű IRF5305 típussal123, míg a kapcsoló FET-et az SI4435124 
típussal  váltottuk  fel.  A mikrovezérlőt,  a  memória  IC-ket,  a  műveleti  erősítőt,  a  diódákat,  a 
kondenzátorokat és az ellenállásokat THT tokozású párjaikkal helyettesítettük.

7.3.1.2 Oszcillátorkonfiguráció
A kvarckristályt  hidegítő kondenzátor  értéke  22pF-re módosult,  az  áramkör  stabilitása  a 

tesztek során így is megfelelőnek bizonyult és ezzel csökkentettük a feléledési időt.

119 Az eredeti PICkit 2 megvásárolható a Microchip cég kizárólagos hazai disztribútoránál a ChipCad kft-nél 8000 Ft.  
+ ÁFA áron, míg ezen áramköri egység megépítésének alkatrészköltsége hozzávetőlegesen 4000 Ft.

120 Az egyik FET-et csak nagyon nagy költségráfordítással lehetett volna THT kiszerelésben alkalmazni, ezért egy 
helyen kénytelenek voltunk SO-8-as tokozást használni.

121 Through Hole Technology – furatszerelt technológia
122 Bármely lábkompatibilis univerzális tranzisztor használható helyettük. Csupán arra figyeljünk, hogy a BC337 NPN, 

a BC327 PNP típusú legyen.
123 Itt is alkalmazható helyettesítés, de az RDSON értékére különösen ügyeljünk!
124 Itt is alkalmazható helyettesítés, de az RDSON érték mellett az alacsony UGS értékre különösen ügyeljünk!
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7.3.1.3 VDD előállító áramkör

Az eredeti  kapcsolási  rajzban (5.2.1.  ábra)  szereplő  R34 jelzésű  ellenállás  szerepe,  hogy 
tápellátás nélkül a FET source pontját stabil GND-re húzza. Ez a tranzisztor tápfeszültség nélkül 
vezérlést  se  kaphat,  ezért  ezt  az  ellenállást  feleslegesnek  ítéltem.  Az  R7 jelzésű  ellenállás 
gondoskodik a +V_TGT125 pont földre húzásáról, ha a FET rDS ellenállása szakadást képvisel. A 
GND-t azonban megkapja ez a pont az R5, R6 soros tagon keresztül is126, tehát az R7 ellenállás 
elhagyható. Az R31 jelzésű ellenállás szerepe számomra nem világos. A Q1 jelzésű FET gate-jén 
nem  folyik  számottevő  áram,  mert  áteresztő  tranzisztorként  működik.  A  gate-en  csupán 
nagyfrekvenciás működtetéskor indulhat meg jelentős áram a CGS kapacitás miatt127, ezért ezt az 
ellenállást nem építettük be. Az így módosított áramköri részlet a 7.3.2.1.4. ábrán látható.

125 U3 jelzésű feszültség
126 10k helyett valójában 20k-val van biztosítva a GND.
127 Az átlagoló RC tag miatt még hibás program esetén se kerülhet erre a pontra nagyfrekvenciás vezérlőjel.
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7.3.1.3.1. ábra: VDD feszültség előállítása a PICkit 2  
klónáramkörben
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7.3.1.4 VDD csatlakoztatása a céleszközhöz

Az eredeti PICkit 2 áramkörben lévő elgondolást (5.2.1.7.1. ábra) egy kissé erőltetettnek 
éreztem, ezért a 7.3.1.4.1. ábrán látható változtatásokat eszközöltem.

A két  FET egy tokban  megoldást  a  Microchip  ki  szerette  volna  használni,  ezért  az  N 
csatornás FET-tel húzták le az VDDTGT' pontot földre. Ezzel a módszerrel valamivel csökkenthető a 
fogyasztás. A PICkit 2 klónáramkörben kialakított megoldás szerint az VDDTGT' pontot stabilan egy 
ellenálláson  (4,7kΩ)  keresztül  csatlakoztatjuk  a  GND  ponthoz.  Az  ellenálláson  folyamatosan 
átfolyó  veszteségi  áram  hozzávetőlegesen  1mA,  amit  elfogadhatónak  ítéltem  a  megspórolt 
költségek figyelembevételével.
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7.3.1.4.1. ábra: VDD csatlakoztatása a céláramkörhöz a klónáramkörben
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7.3.1.5 Nyomógomb illesztése

A  nyomógombot  a  7.3.1.5.1.  ábrán  látható  módon  csatlakoztattuk  a  mikrovezérlőhöz.  A 
szűrőáramkörhöz tartozó R1 ellenállás védelmi célokat128 is ellát.

Az áramköri részlet felfogható egy egyszerű 
szűrőráramkörnek,  amelyet  5V-os  AC 
generátorral  hajtunk  meg.  A frekvenciát  a 
nyomógomb prellideje határozza meg. R1 és 
R2 ellenállás  nem  növelhető  a 
végtelenségig, hiszen a mikrovezérlő a nagy 
impedanciákat  nem tolerálja  a  bemeneten. 
Mindemellett  a  nyomógomb  megfelelő 
üzemeltetéséhez is szükséges egy minimális 
(öntisztítási)  áram.  R1 ellenállás  minimális 
értéke 220Ω129

Az R1, R2 és C elemek által alkotott aluláteresztő szűrő méretezése Hendrik Wade Bode hálózati 
analízis módszere szerint történik. A . ábrán látható áramkör átviteli függvénye a következő:

128 330Ω-os soros védő ellenállásként működik.

129 Rossz iránybeállítás esetén: Rmin=
Umax
I max

= 5V
25mA

=200Ω
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7.3.1.5.1. ábra: Nyomógomb illesztése a PICkit 2 klónáramkörhöz
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Az
1

1ST szabványos  Bode-alakban  szereplő  időállandót  az  RC  elemekből  kapjuk: 

T=RC =10,33 kΩ⋅10μF=103,3 ms .  Az  ebből  adódó  frekvencián  (

ω= 1
T

 f = 1
2Π⋅103,3 ms

≈1,5 Hz ) az áramkör már 3dB-es csillapítással rendelkezik.

Az amplitúdó-frekvencia karakterisztikából jól látható, hogy 10Hz környékén már 20dB-es 
(10-szeres)  csillapítást  érünk  el,  így  az  5V-os  pergő  jelből  már  csak  0,5V jut  a  mikrovezérlő 
bemenetére, amit már nullának érzékel.
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7.3.1.5.3. ábra:
Nyomógomb pergésmentesítő áramkörének amplitúdó- és fázismenete
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7.3.1.6 Állapotjelző LED-ek
A 7.3.1.6.1. ábrán látható kapcsolási rajzon DS1 jelzésű Busy LED áramkorlátozó ellenállása 

a  negatív  szálba  került  –  a  műszaki  gyakorlatban  mindig  a  pozitív  ágba  helyezzük  el  a 
védőellenállásokat (7.3.1.6.1. ábra).

7.3.1.7 Target csatlakozófelület
A  klónáramkör  megtervezésekor  a  céláramkörrel  való  kapcsolatot  szabványos 

tápcsatlakozókkal biztosítottuk.  A memória IC-k külön csatlakozókat kaptak (7.3.1.7.1.  ábra).  A 
mikrovezérlőhöz  tartozó  csatlakozó  kiosztása  (7.3.1.7.2.  ábra)  kompatibilis  a 
http://plc.mechatronika.hu weboldalon megtalálható ICD2-vel. A HOST mikrovezérlőhöz kívülről 
az  eredeti  PICkit  2-ben  is  megtalálható  tápfeszültség  megfogó  és  egyben  túlfeszültségvédő 
tranzisztoros  áramköri  részleten,  valamint  multifuse  regenerálódó  biztosítékkal  megvalósított 
túláram-védőn keresztül kapcsolódhatunk (7.3.1.7.3. ábra). A PGC és PGD lábak ezen felül egy 
4066 analóg kapcsolóval szoftveres úton leválaszthatók.
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7.3.1.6.1. ábra: LED csatlakoztatása a mikrovezérlőhöz
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7.3.1.7.2. ábra:Target mikrovezérlő lábkiosztás a klónáramkörön
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7.3.1.7.3. ábra: Target ICSP csatlakozó védelme a klónáramkörben
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7.3.1.8 USB csatlakozó felület

A  PC-vel  történő  kommunikációt  biztosító  USB  csatlakozót  elláttuk  túlfeszültség  és 
túláram-védelemmel. A kapcsolási rajzon látható módon a Zener-dióda 5,1V-on megfogja a vonalat, 
a multifuse típusú regenerálódó biztosíték pedig nem engedi az adott érték (50mA, és 500mA) fölé 
menni az áramot.

7.3.1.9 Tápfeszültség kiválasztása

A Programmer  –  To  –  Go  funkció  lényege,  hogy  PC  nélkül  is  tudjunk  programozni, 
felhasználva a PICkit 2 áramkörben lévő EEPROM memóriákat. A funkció komoly hibája, hogy 
USB-s csatlakozón igényli az 5V-os tápfeszültséget a működéshez. A klónáramkörön egy jumper 
segítségével ki tudjuk választani, hogy az USB csatlakozóról, vagy a Target áramkörről szeretnénk 
meghajtani a Host mikrovezérlőt.
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7.3.2 PICkit 2 klónáramkör elkészítése130

Csak  a  7.3.1.  fejezet  elolvasása  után  kezdjünk  hozzá  az  áramkör  megépítéséhez.  A 
http://plc.mechatronika.hu weboldalról töltsük le a szükséges dokumentációt (leírás, kapcsolási rajz, 
nyákterv).

7.3.2.1 Szereletlen NYÁK131 ellenőrzése
A NYÁK kimaratása után ellenőrizzük a lemezt szemrevételezéssel, és végezzünk műszeres 

mérést(!) is. A vezetősávokkal összekapcsolni kívánt pontok között DMM132 segítségével mérjünk 
ellenállást133! Ezek után a vezetősávokkal összekötött szigeteket egy pontként kezelve ellenőrizzük 
a szakadást  közöttük!  Egy NYÁK-on maximum 3 hibát javítsunk, ha ennél többel találkozunk, 
készítsünk új áramköri lapot!

Szemrevételezéssel a 7.3.2.1.1. ábrán látható vezetősáv-elvékonyodás (túlmaratás, alámarás) 
és vezetősáv-zárlat hibákat tudjuk felfedezni.

Az 1-2 pontok közötti vezetősávon a jellemzően előforduló alámarást, míg a 2-3, és 2-4 
pontok között a nem megfelelően előkészített NYÁK134 miatti hibát láthatjuk. A 6, és az 5 pontok 
nem különülnek el az 1-2-3-4 pontok által alkotott szigettől – ez lehet valamilyen szennyeződés 
miatt, ill. a túl rövid maratástól.

130 Az  itt  olvasható  leírás  célja,  hogy  elkerüljük  az  „összeraktam,  de  nem  működik,  mi  lehet  a  baj?!?”  típusú 
hibajelentéseket, kérdéseket.

131 Nyomtatott Áramköri Kártya, vagy NYHL – Nyomtatott Huzalozású Lemez
132 Digitális Multiméter
133 A legtöbb multiméter diódamérés állásban csipogással jelzi a rövidzárt (ez típusonként változhat, pl. <10Ω; <90Ω)
134 Ha a  lemezt  nem tisztítjuk  meg kellőképpen,  a  szennyeződések  komoly hibákat,  vezetősáv  kihagyásokat,  ill.  

zárlatokat okozhatnak.
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7.3.2.1.1. ábra: Szereletlen NYÁK 
ellenőrzése szemrevételezéssel
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Műszeres vizsgálat: Állítsuk a multimétert rövidzár méréshatárba (folyamatosságvizsgálat, 
szakadás  mérés).  A  7.3.2.1.2.  ábrán látható példa esetében a 
műszer  egyik  mérővezetékét  csatlakoztassuk az  1.  pontra.  A 
másik  mérővezetéket  érintsük  hozzá  sorrendben  a  2,  3,  4 
pontokhoz  –  mindegyik  esetben  rövidzárt  kell  mérnünk. 
Tegyük át az eddig nem mozgatott mérővezetéket az 5. pontra, 
majd  a  másikat  sorban  a  6-os  a  7-es  és  a  8-as  pontokra  – 
mindhárom  esetben  rövidzárt  kell  mérnünk.  A  két  sziget 
tetszőleges  pontját  (pl.  1,  5)  kiválasztva  közöttük  szakadást 
kell mérnünk.

Beültetendő alkatrészek vizsgálata

Ellenállások: Az ellenállásokat színkódjuk, vagy feliratozásuk alapján azonosítsuk be, majd 
ellenőrizzük  értékeiket.  Az  emberi  ellenállás  –  függően  a 
személytől,  helytől,  lelkiállapottól,  stb.  –  n*100kΩ135 
nagyságrendbe esik, ezért 10kΩ-os ellenállásig nem követünk 
el komoly hibát, ha belemérjük a testünket is.

Kapacitások: Amennyiben olyan multiméterrel rendelkezünk, amelynek van kapacitásmérő 
méréshatára,  használjuk  ezt  az  opciót.  A  7.3.2.1.3.  ábra  egy 
alternatív mérési elrendezést mutat, melyben az integrálási idő 
alapján  számolhatunk.  (Elektrolit  kondenzátoroknál  –  a 
névleges  feszültség  mellett  –  ügyelnünk  kell  a  helyes 
polaritásra)

135 Figyelem: érintésvédelem esetén egységesen 1kΩ-al számolunk a legrosszabb esetre (worst-case).
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7.3.2.1.2. ábra:
A szereletlen NYÁK műszeres vizsgálata
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Induktivitás: Induktivitást csupán a drágább multiméterek képesek korlátozott mértékben 
mérni.  A  kapacitásmérésnél  bemutatott  elrendezéshez 
hasonlóan  azonban  az  induktivitás  értéke  is  meghatározható 
(csupán az alkatrészek pozícióit kell felcserélni).

Diódák: A DMM mérőműszert állítsuk dióda méréshatárba. A pozitív mérővezetéket 
az  anódra,  a  negatívat  a  katódra  téve  mérjük  a  dióda 
nyitófeszültségét  (egyenirányító:  0,5V÷0,75V;  schottky: 
0,25V÷0,4V).  A mérőzsinórokat  megcserélve  szakadást  kell 
mérnünk136.

Tranzisztorok: A DMM mérőműszert  állítsuk dióda méréshatárba.  NPN tranzisztor 
esetén a pozitív mérővezetéket helyezzük a bázisra, a negatívat 
pedig az emitterre és mérjük a tranzisztor BE nyitófeszültségét 
(~0,6V).  Helyezzük  át  a  negatív  mérőzsinórt  a  kollektor 
pontra,  és  mérjük  a  BC  nyitófeszültséget  (~0,6V).  A  két 
mérővezetéket  a  kollektor  és  az  emitter  közé  helyezve 
szakadást  kell  mérnünk.  PNP  tranzisztor  esetén  hasonlóan 
járunk el, azonban a mérővezetékeket megcseréljük137.

136 Típustól függően a mérőműszer vagy a maximális értéket jelzi (pl. 1500), vagy méréshatár túllépést jelez (pl. villog 
az érték).

137 Mivel a DMM lebegő bemenetű műszer ezért nem követünk el hibát, ha felcseréljük a vezetékeket, csak ekkor 
negatív értéket kapunk. Ebből következően egyszerűen el tudjuk dönteni, egy tranzisztorról, hogy NPN, vagy PNP 
típusú-e: a pozitív mérővezetéket a bázisra helyezve, a negatívot az emitterre, vagy a kollektorra csatlakoztatva – 
pozitív érték esetén NPN, negatív érték esetén PNP tranzisztorral van dolgunk.
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7.3.2.1.3. ábra: Kapacitásmérés az integrálási időre visszavezetve
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Integrált áramkörök: A  PICkit2-ben  lévő  integrált  áramkörök  közül  a  műveleti 
erősítőt tudjuk egyszerűen tesztelni – a 7.3.2.1.4. ábra szerinti 
elrendezésben  mérjük  a  műveleti  erősítő  ofszet  feszültségét 
(katalógus adat [mV nagyságrend]).

7.3.2.2 Alkatrészek beültetése
Az  alkatrészek  beültetésénél  ügyeljünk  a  gondos  és  precíz  munkára.  Csak 

hőfokszabályozóval  ellátott  Weller  pákával  kezdjünk  neki  a  munkának  –  a  pillanatpákákat 
hanyagoljuk.  Vegyük figyelembe,  hogy az egyes  alkatrészek eltérő mértékben tolerálják a  nagy 
hőmérsékletet.

Fokozott  figyelemmel  helyezzük  el  a  polaritással  rendelkező  alkatrészeket,  mert  ezek 
helytelen pozícióba történő ültetése nem csak hibás működéshez, de az eszköz tönkremeneteléhez is 
vezethet.

Ha  rossz  helyre,  pozícióba  ültettünk  be  alkatrészt  a  kiszedésénél  mindig  használjunk 
ónszippantót, és/vagy ónszívó sodratot.

A PICkit2 klónáramkör alkatrészeinek beültetési sorrendje a következő:

• átkötések
• ellenállások
• diódák
• kvarckristály
• induktivitás
• nyomógombok
• dip foglalatok
• száraz kondenzátorok
• LED-ek
• Target ICSP csatlakozók
• 50mA  multifuse biztosítékok
• bipoláris tranzisztorok
• Host ICSP csatlakozó
• elektrolit kondenzátorok (kivétel 1000μF)
• 500mA multifuse biztosítékok
• USB csatlakozó
• 1000μF
• FET-ek
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7.3.2.1.4. ábra: Műveleti erősítő ellenőrzése
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7.3.2.3 Bemérés

A kész PICkit 2 klónáramkört a  6.4. fejezetben leírtak szerint csatlakoztassuk a PC-hez és 
ellenőrizzük a működőképességét.  Helyes működés esetén használjuk egészséggel a szerkezetet. 
Amennyiben hibát tapasztalunk a következők szerint járjunk el138:

• Passzív panelen szemrevételezéssel ellenőrizzük a beforrasztott nyákot – nem egyértelmű 
helyzetben alkalmazzunk multimétert a folyamatosságvizsgálathoz.

• Passzív panelen ellenőrizzük a PC-hez történő csatlakozás épségét multiméter segítségével.
• Aktív  panelen  ellenőrizzük  a  szükséges  tápfeszültségeket  (PIC  mikrovezérlő,  műveleti 

erősítő).
• Oszcilloszkóp segítségével ellenőrizzük, hogy a PIC mikrovezérlő oszcillátora rezeg-e.
• Aktív panel esetén a biztosítékokon helyes konstrukcióban csupán néhány mV feszültség 

eshet – amennyiben ennél többet mérünk valahol az áramkörben rövidzárlat történt.
• Lépjünk be a PICkit 2 szoftver hibakereső üzemmódjába (6.3.4.1. fejezet).
• Mérjük végig  az  egyes  részáramköröket,  hogy a  leírásban  bemutatottaknak  megfelelően 

működnek-e.

138 Mielőtt a hibakeresést megkezdjük – amennyiben eddig nem tettük – mindenképpen vizsgáljuk meg, hogy milyen  
eltérések  mutatkoznak  a  klónáramkör  és  az  eredeti  PICkit  2  között  –  s  ennek  függvényében  végezzük  a  
hibaelhárítást.
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7.3.2.4 Kapcsolási rajz

7.3.2.4.1. ábra: PICkit 2 klón kapcsolási rajz 1/2



7.3.2.4.2. ábra: PICkit 2 klón kapcsolási rajz 2/2



Melléklet

7.3.2.5 Alkatrészlista

Megnevezés Érték Tokozás Megjegyzés/
darabszám

Cikkszám 
(Lomex)

Ellenállások (Fémréteg, vagy szénréteg 2 raszteres ellenállások, E24)
R27, R28, R29, R34 33Ω MF0204 0,4W / 1db 02-07-64

R26 100Ω MF0204 0,4W / 1db 02-06-77
R9, R10 270Ω MF0204 0,4W / 6db 02-07-88

R3, R4, R5, R11, R33 330Ω MF0204 0,4W / 4db 02-06-79
R32 680Ω MF0204 0,4W / 1db 02-07-97

R8, R19, R22, R25 1kΩ MF0204 0,4W / 4db 02-06-80
R1, R2, R21 2,7kΩ MF0204 0,4W / 3db 02-08-09

R7, R17, R18, R20, 
R30, R31

4,7kΩ MF0204 0,4W / 6db 02-08-14

R6, R12, R13, R14, 
R15, R16, R24

10kΩ MF0204 0,4W / 7db 02-06-83

R23 100kΩ MF0204 0,4W / 1db 02-06-85

Kondenzátor
C5, C6 15pF SSM 15 NPO / 2db 07-09-64

C7 1nF SSM 15 NPO / 1db 07-10-09
C1, C3, C17 22nF SSM 15 X7R / 3db 07-01-30

C10, C14 47nF SSM 16 X7R / 2db 07-03-08
C9 220nF SSM 16 Y5V / 1db 07-09-03
C13 220nF WIM Fólia / 1db 07-05-30
C8 1μF SSM 16 Y5V / 1db 07-03-27

C2, C4, C18 2,2μF 4X5 (YAG) 50V / 3db 12-04-28
C11, C15 4,7μF 4X7(YAG) 50V / 2db 12-01-36

C16 47μF 6X11 (YAG) 50V / 1db 12-06-54
C12 1000μF 10X19 (YAG) 25V / 1db 12-04-70

Induktivitás

L1 680μH Axiális 4X10,5 
(YAG) 0,113A / 1db 55-00-93
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Dióda

D1, D2, D3, D7 BZX85C5V1 DO-41 5,1V 1,3W Zener / 
7db 18-00-75

D8 BZX85C15 DO-41 15V 1,3W Zener / 
1db 18-00-77

D4 1N4148 DO-35 Kapcsoló (0,15A) / 
1db 16-02-45 

D6, D9 BAT86 DO-34 Schottky (0,2A) / 
1db 16-03-49

D5 1N5819 DO-41 Schottky (1A) / 1db 16-02-71
LED1, LED5 L-934PGT Ø3mm Zöld / 1db 34-01-22

LED2 L-934IT Ø3mm Piros / 1db 34-01-51
LED3 L-934YDLK Ø3mm Sárga / 1db 34-05-20
LED4 L-934NC Ø3mm Narancs / 1db 34-01-41

Tranzisztor
T1, T2, T3 BC337 TO-92 NPN (0,8A) / 3db 21-07-97

T4, T7, T8, T9 BC327 TO-92 PNP (0,8A) / 1db 21-07-19

T5 IRF5305 TO-220
P-FET RDSon<0,06Ω 

/ 1db
21-08-08

T6 SI4435BDY-E3 SO-8
P-FET 

RDSon<0,015Ω / 1db 86-01-63 

Kvarckristály
Q1 HC49/S Low profil 20Mhz / 1db 40-01-21 

Integrált áramkör (IC)
IC1 PIC18F2550 DIP-28 1db ChipCad

IC3, IC4 24LC512 DIP-8 2 db ChipCad
IC2 MCP6002139 Dip-8 1 db ChipCad
IC5 CD4066BE DIP-14 1 db 31-02-38

Biztosíték
F1, F2, F3, F4 MF-R005 D=7,4 Multifuse / 8 db 44-01-72
F6, F9, F10, F11 MF-R010 D=7,4 Multifuse / 8 db 44-00-66 

F5, F7, F8 MF-R050 D=7,9 Multifuse / 3 db 44-00-71

139 Helyettesíthető: TLC-272CP (Cikkszám: 32-04-13) 
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Nyomógomb

S1, S2 FSM6JH TACT 6X6 Nyák nyomógomb /
2 db 45-05-38

Foglalat
PDIP DIP-28 1db 41-00-47
PDIP DIP-14 1 db 41-00-51
PDIP DIP-8 2 db 41-00-58

Csatlakozó

ST1 NCW254-03R 3P 90° Tápcsatlakozó apa / 
1 db 43-09-95

ST2 NCW254-04R 4P 90° Tápcsatlakozó apa / 
1db 43-09-96 

ST3 NCW254-05R 5P 90° Tápcsatlakozó apa / 
1db 43-09-97 

ST4 NCW254-06R 6P 90° Tápcsatlakozó apa / 
1db 43-09-98

NCH254-03 3P Tápcsatlakozó anya 
ház / 1db 43-09-07 

NCH254-04 4P Tápcsatlakozó anya 
ház / 1db 43-09-08

NCH254-05 5P Tápcsatlakozó anya 
ház / 1db 43-09-09

NCH254-06 6P Tápcsatlakozó anya 
ház / 1db 43-09-10

NCT254-T Krimpelhető Tápcsatlakozó anya 
/ 20 db 43-09-17 

JP1 6P 2,54 / 1db 43-07-21
JP2 3P 2,54 / 1db 43-07-21
JP3 2P 2,54 / 1db 43-07-21

Hüvelysor 20P140 2,54 / 1db 43-00-08 
X1 USB-B USB-B04FH-S 90° anya / 1db 43-14-75

Vezeték
USB A-B 1,8m / 1db 54-01-42

ICSP vezeték 6X0,22 2m 54-00-47
Zsugorcső Ø1mm 1m 53-00-21
Zsugorcső Ø4mm 1m 53-00-19

140 Függ attól, hogy a Target felé milyen csatlakozókat szeretnénk kialakítani.
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A  PIC  mikrovezérlőket,  az  MCP6002  típusú  műveleti  erősítőt  és  a  soros  EEPROM 
memóriákat  a  CHIPCAD  kft-től  lehet  beszerezni.  A  többi  alkatrész  kapható  a  legtöbb 
kiskereskedelmi egységben pl. Lomex.

7.3.3 Firmware ismertetése

A PICkit 2 áramkört működtető firmware forrása nyilvános. A klón működéséhez az aktuális 
firmware-t módosítani kell. A plc.mechatronika.hu weboldalon megtalálható a hex fájl, melyben a 
4066 analóg kapcsoló működtetése már meg van oldva. A firmware leíró részében módosítottuk az 
igényelt áramot is, így a szoftveres áramkorlát már 480mA lett. Mindemellett a Programmer - To 
Go  funkciónál,  ill.  a  VDD bekapcsolásánál  is  apróbb  módosításokat  eszközöltünk.  A következő 
fejezet részletesen ismerteti a változtatásokat és azok okait.

7.3.3.1 Változtatások a gyári firmware-ben

A nyilvánosságra  hozott  módosított  firmware-ben  a  változtatásokat  megjegyzésben  elláttuk  a 
„Javítás” karaktersorozattal.

7.3.3.1.1 PICkit2_FWv2 projekt módosítása

Módosított fájlok:

• IO_CFG.H lábkonfigurációs headerfájl

• USBDSC.C leíró fájl

• PICKIT.C főprogram

• PICKIT2.ASM assembly primitív

• PK_PROG2GO.C Programmer – To – Go funkcióhoz készített függvények

Az IO_CFG.H fájlban definiáltuk a 4066 típusú analóg kapcsolót vezérlő RC7 lábat (7.3.3.1.1.1. 
ábra).
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7.3.3.1.1.1. ábra: Analóg kapcsoló vezérlőlábának definiálása

http://www.lomex.hu/
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Az USBDSC.C leíró  fájlban  módosítottuk  a  PICkit2  által  küldött  áramigényt  az  eredeti 
100mA-ről 480mA-re141 (7.3.3.1.1.2. és 7.3.3.1.1.3. ábra).

141 Ezt az értéket a CFG01 és CFG02 konfigurációs leíróban találjuk. Az eredetileg megadott 50-es számértéket 240-re 
módosítottuk.
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7.3.3.1.1.2. ábra: CFG01 módosítása

7.3.3.1.1.3. ábra: CFG02 módosítása
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A PICKIT.C fájlban több módosítást is el kellett végezni.

A  7.3.3.1.1.4.  ábrán  láthatjuk,  hogy  a  VDD_TGT_N  láb  (RB3)  irányát  bemenetre 
módosítottuk, mivel a klónáramkörben ez a funkció nincs megvalósítva. A PORTB-n lévő felhúzó 
ellenállásokat  kikapcsoltuk,  mert  az  RB5-re  kötött  nyomógomb  rendelkezik  saját  felhúzó 
ellenállással. Mindemellett a PROG_SWITCH_pin = 1 sort kikommenteztük, hiszen a bemenetre 
nem érdemes ráírni.

A 7.3.3.1.1.5. ábrán látható utasítások az PICkitInit() inicializáló függvényben helyezkednek 
el.  Bekapcsoláskor, vagy reszet esetén biztosítanunk kell,  hogy a 4066 analóg kapcsoló a PGC, 
PGD lábakat leválassza a targetről (vagyis kimenetként kell konfigurálnunk a vezérlőlábát és 0-s 
kezdőértéket kell kapnia).
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7.3.3.1.1.4. ábra: PORTB felhúzó ellenállásainak kikapcsolása

7.3.3.1.1.5. ábra: A 4066 típusú analóg kapcsoló kikapcsolása, irányának megadása
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A  7.3.3.1.1.6.  ábrán  láthatjuk,  hogy  egy  új  –  az  eredeti  firmware-ben  nem  szereplő  – 
függvényhívás történik. A PK2Go_SET_VDD() függvény a belső EEPROM-ból kiolvassa az előre 
megadott VDD feszültségértéket és ezt állítja be. Erre azért volt szükség, mert a funkcióba való 
belépést  a  PICkit2  hardveregység  a  VDD be-  és  kikapcsolgatásával  jelzi.  Azért,  hogy  a  3V3 
rendszerű PIC mikrovezérlőket ne tegye tönkre a firmware a VDD feszültségértékét a target LED 
villogtatásához visszaveszi bekapcsoláskor 3,3V, majd a későbbi működés során 1,8V értékűre142.

A probléma ott adódik, hogy ha nem csak a PIC mikrovezérlőt, hanem egy azt tartalmazó 
panelt  szeretnénk  céláramkörnek  választani.  Amennyiben  a  panelen  minimális  pufferelem  (pl. 
100μF) ki van alakítva a 3,3V, ill. az 1,8V már kevés egy 5V-ra tervezett áramkör tápellátására. A 
módosítás következtében a PICkit2 a Programmer – To – Go funkcióba történő belépéskor az előre 
megadott értékű VDD feszültséggel fogja villogtatni a target LED-et. Ezzel a változtatással előáll az 
a veszély,  hogy ha rossz eszközt és feszültségértéket választottunk ki a beállítások során, akkor 
nagyobb feszültséget adunk a panelre mint amit elviselne. Mivel ennek esélye korrekt használat 
esetén elhanyagolható,  ezért  úgy ítéltük meg,  hogy a módosítás  elfogadható kockázattal  jár143.  

Mindemellett a 7.3.4. fejezetben láthatunk egy alternatívát erre a problémára.

142 Ennek elkerülése végett a CallAndSetCCP1() függvény, ill. az utána lévő utasítás kikommentezésre került.
143 A PICkit2 firmware-je 125μs-onként ellenőrzi a VDD feszültség értékét, és meghatározott eltérés esetén lekapcsolja 

azt.
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7.3.3.1.1.6. ábra: Programmer – To – Go funkció esetén VDD alapállapot biztosítása
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A  7.3.3.1.1.7.  ábrán  láthatjuk,  hogy az  UART módba történő belépéskor  a  4066 analóg 
kapcsolót be, kilépéskor pedig ki kell kapcsolnunk.

A  7.3.3.1.1.8.  ábrán láthatjuk,  hogy a logikai  analizátor  mód is  magával  vonzza a 4066 
analóg kapcsoló működtetését.
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7.3.3.1.1.7. ábra: UART módban történő működés esetén a 4066 kapcsolása

7.3.3.1.1.8. ábra: A 4066 vezérlése logikai analizátor üzemmódban
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A  7.3.3.1.1.9.  és  a  7.3.3.1.1.10.  ábrán  látható  módosítások  okairól  már  beszéltünk.  A 
képeken  a  Programmer  –  To  –  Go  funkció  esetén  1,8V-ra  visszavett  VDD feszültség 
kikommentezését  láthatjuk.  A  7.3.3.1.1.9.  ábrán  mindemellett  kiszedtük  a  VDD_TGT_N  láb 
kapcsolását is.

A  7.3.3.1.1.12.  ábrán  láthatjuk,  hogy  a  VDD FET-el  történő  földre  kapcsolását 
kikommenteztük, hiszen ez a pont egy ellenálláson keresztül már stabil földre van kötve.
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7.3.3.1.1.11. ábra: VDD figyelés kikapcsolása a bekapcsolási jelenségek lefutásáig

7.3.3.1.1.9. ábra: VDD 1,8V-ra történő csökkentésének elhagyása

7.3.3.1.1.10. ábra: VDD 1,8V-ra történő csökkentésének elhagyása
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A 7.3.3.1.1.11. ábrán látható, hogy a VDD bekapcsolása előtt kikapcsoljuk a VDD figyelést, 
majd egy várakozási rutin után ismét bekapcsoljuk. Erre azért van szükség, hogy egy panelen lévő 
pufferkondenzátort is fel tudjunk tölteni. A kondenzátor a feszültség rákapcsolásának pillanatában 
rövidzárként viselkedik, és a PICkit2 VDD error hibaüzenettel lekapcsolja a tápfeszültséget. Ennek 
megakadályozására  bekapcsoláskor  egy  kis  időt  adunk  az  áramkörnek,  majd  folytatjuk  a  VDD 

monitorozását.

A  PGC  és  PGD  lábakat  a  programozás/hibakeresés  idejére  csatlakoztatnunk  kell  a 
céláramkörhöz a 4066 analóg kapcsoló segítségével. A programozási, vagy hibakeresési módba való 
belépésről a VPP láb üzemeltetése nyújt számunkra információt. A 7.3.3.1.1.13. ábrán látható ennek 
fényében a 4066 vezérlése.
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7.3.3.1.1.13. ábra: 4066 vezérlése a VPP függvényében

7.3.3.1.1.12. ábra: VDD láb FET-el való földre húzásának kikommentezése
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A 7.3.3.1.1.14. és a  7.3.3.1.1.15. ábrán látható függvény egy maximum 700ms ideig tartó 
impulzus mérését végzi a PGD lábon – ahhoz hogy ezt végre tudja hajtani a 4066 kapcsolót a 
függvény elején be, a végén pedig ki kell kapcsolnunk.

A  7.3.3.1.1.16.  és  a  7.3.3.1.1.17.  ábrán  látható  függvények  az  I2C-n  kommunikáló 
EEPROM-ok felprogramozásához szükséges kommunikációt indítják, ill. állítják le – a javítás itt is  
a 4066 vezérlését szolgálja. 
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7.3.3.1.1.14. ábra: Impulzusmérő függvény kezdete

7.3.3.1.1.15. ábra: Impulzusmérő függvény vége

7.3.3.1.1.16. ábra: 4066 bekapcsolása az I2C START bit generáláskor
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A 7.3.3.1.1.18. és a 7.3.3.1.1.19. ábrán látható függvények az SPI kommunikációt biztosítják 
az AUX és PGD lábakon. Itt is a 4066 működtetésére szolgáló utasításokat szúrtuk be.
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7.3.3.1.1.17. ábra: 4066 bekapcsolása az I2C STOP bit generáláskor

7.3.3.1.1.18. ábra: 4066 bekapcsolása az SPI kommunikáció indításakor

7.3.3.1.1.19. ábra: 4066 kikapcsolása az SPI kommunikáció befejezésekor
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A  PICKIT2.ASM  fájlban  assembly  rutinokat  találunk,  amelyeket  általában  a 
sebességoptimalizálás, vagy az egyszerűbb értelmezés végett alkalmaztak.

A 7.3.3.1.1.20. ábrán láthatjuk, hogy a 32-es sorozatú PIC mikrovezérlők programozásához 
egy  JTAG144 assembly  rutint  alkalmaztak.  A  helyes  működés  megköveteli,  hogy  itt  is 
csatlakoztassuk, majd leválasszuk a PGC, PGD lábakat.

144 A JTAG a boundary scan egyik lehetséges megvalósítási protokollja – jóval fejlettebb tesztelési és programozási 
eljárás, mint az ICSP.
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7.3.3.1.1.20. ábra:
4066 analóg kapcsoló működtetése PIC32 JTAG primitív esetén



Melléklet

A PK_PROG2GO.C fájl  tartalmazza  a  Programmer  –  To – Go funkció  működtetéséhez 
szükséges függvényeket.

A 7.3.3.1.1.21. ábrán láthatjuk a Programmer – To – Go funkció esetén meghívott VDD 
beállító függvény (l. 104. o.) deklarációját, a 7.3.3.1.1.22. ábrán pedig a függvény definíciót.
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7.3.3.1.1.21. ábra: PkGo_SET_VDD() függvény deklarálása

7.3.3.1.1.22. ábra: PkGo_SET_VDD() függvény definíciója
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7.3.3.1.2 PICkit2Bootloader projekt módosítása

A bootloaderben a BOOT_MAIN.C fájlt kellett megváltoztatnunk.

Első lépésként a 7.3.3.1.2.1. ábrán látható konfigurációs biteket javítottuk. A szükségesnek 
ítélt módosítások:

• Az eredeti  firmware-ben FCMEM szerepelt,  ezt  az alkalmazott  fordító  miatt  FCMEN-re 
kellett változtatnunk.

• A Brown Out Reset-et a stabilabb működés érdekében engedélyeztük.

• A Master Clear Reset-et engedélyeztük, mert a klónáramkör kiegészült egy nyomógombbal, 
amivel reszetelni lehet az eszközt.

• Az ICPRT bitbeállítást kiszedtük, erre szintén a fordító miatt volt szükség.
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7.3.3.1.2.1. ábra: Konfigurációs bitek módosítása
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A  7.3.3.1.2.2.  ábrán  láthatjuk,  hogy  a  bootloader  módba  való  belépésen  is  változtatást 
eszközöltünk. A 122. sorban kikommenteztük a bemenetre történő ráírást. A 127. sorban szintaktikai 
hiba  volt,  az  eredeti  verzióban  PROG_SWITCH  szerepelt,  de  az  IO_CFG.H  fájlban  a 
nyomógombot  PROG_SWITCH_PIN-ként adtuk meg, ezért erre módosítottunk itt is.

A 133.  sorban egy feltételvizsgálatot  láthatunk.  A letöltőprogramot kétféleképpen tudjuk 
elindítani. Egyik lehetőség, hogy a nyomógombot lenyomva tartva csatlakoztatjuk a PICkit2-őt a 
PC-hez,  ekkor  a  127.  sorban  lévő  feltétel  nem  teljesül145 és  tovább  megyünk  a  bootloader 
programban – ellenkező esetben megvizsgáljuk a másik lehetőséget. A PICkit2 szoftveréből egy 
parancs segítségével  is  a bootloader  módba léphetünk (Tools → Download PICkit  2 Operating  
System).  A parancs  hatására  a  PICkit  2  firmware-e  kitörli  az  utolsó  memóriarekesz  tartalmát 
(0x7FFE),  majd reszeteli az áramkört.  Amikor tehát elindul a program meg kell  néznünk, hogy 
ebben a memóriarekeszben nulla van-e146, amennyiben igen akkor bootloader módba kell lépnünk, 
ha  nem  akkor  a  normál  működés  esete  áll  fenn  (GOTO  RM_RESET_VECTOR).  Az  eredeti 
verzióban 0x55-öt vizsgált a program, ami helytelen, ezt módosítottuk 0x00-ra.

145 A nyomógomb nullába húz (aktív nullás eszköz).
146 Normál működés esetén ezt a rekeszt nem használjuk, mivel a programmemóriában eddig nem foglalunk helyet 

felprogramozásnál 0xFF értékű marad.
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7.3.3.1.2.2. ábra: Bootloader módba történő belépés feltételvizsgálatának módosítása
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A 7.3.3.1.2.3. ábrán látható módosításokat az USB kommunikáció helyes működése végett 
eszközöltük.
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7.3.3.1.2.3. ábra: USB kommunikációs eljárás módosítása
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7.3.3.2 A firmware-n történő módosítások elvégzése MPLAB környezet alatt

A gyári firmware-t két külön projektből állították össze az Microchip mérnökei. Az egyik 
projekt  tartalmazza  a  pickit  2  funkcióit  ellátni  képes  forrásokat,  míg  a  másik  projektben  a 
bootloader147 kapott helyet.

Az MPLAB Configure → Settings menüpontjának Projects fülénél vegyük ki a pipát a Use 
one-to-one project-workspace model opcióból! Így már tudunk egyszerre több projektet is kezelni a 
munkaasztalunkon. A Program Loading fülnél tudjuk beállítani, hogy a projektünk fordítása előtt 
(Clear  memory  before  building  a  project),  vagy  sikeres  fordítása  után  (Clear  memory  after  
succesfully building a project) melyik memóriaterületet törölje a fejlesztőrendszer. Ügyeljünk rá, 
hogy egyik lehetőség se legyen bepipálva, hiszen pl. amennyiben a programmemóriát töröljük a 
projekt fordítása előtt, akkor mindig csak az egyik projekt tartalma jelenik meg a memóriában amit 
majd letöltünk a mikrovezérlőbe148.

A  Configure  →  Select  Device...  menüpontban  válasszuk  ki  a  PIC18F2550  típusú 
mikrovezérlőt!

Nyissuk  meg  a  Microchip  honlapjáról  letöltött  PICkit2_FWv2.mcp  és  a 
PICkit2Bootloader.mcp nevű projekteket! A fordításhoz használjuk a Microchip C18 fordítóját149 
(Project  →  Select  Language  Toolsuite...).  Amennyiben  szükséges  adjuk  meg  a  fordítóeszköz 
komponenseinek elérési útját a  Project → Set Language Tool Locations... menüpont segítségével. 
A Project → Build Options... menüpont  Project fülében állítsuk be a könyvtárakat! A libary és a 
linker elérési útjaként adjuk meg az XXX\MCC18\LIB és az XXX\MCC18\LKR könyvtárakat. Az 
include  fájlokhoz  rendeljük  hozzá  az   XXX\MCC18\H  és  a  firmware  fő  könyvtárának 
(XXX\FirmwareV2)  elérési  útját.  A  Project  →  Build  Configuration menüpontban  válasszuk  a 
Release opciót! A projektet mentsük el,  majd a  Project Set Active projekt fülnél válasszuk ki a 
másik projektünket és ismételjük meg a folyamatot.

Tegyük  aktívvá  a   PICkit2_FWv2.mcp  nevű  projektet,  végezzük  el  a  szükséges 
módosításokat,  majd a Ctrl+F10 billentyűkombinációval fordítsuk le.  A  PICkit2Bootloader.mcp 
nevű  projekt  aktívvá  tétele  és  a  változtatások  elvégzése  után  ismét  alkalmazzuk  a   Ctrl+F10 
billentyűkombinációt a fordításhoz. A sorrend fontos, mivel két main() függvény szerepel a fordító 
mindkettőt  a nullás  címre kívánja fordítani,  ott  pedig a  bootloader helye  van – vagyis  midig a 
letöltőprogram projektjét kell utoljára fordítanunk! A programmemóriában szerepelnie kell mindkét 
projekt eredményének. A File → Export...150 menüpont segítségével a programmemóriából egy hex 
fájlba tölthetjük a programunkat, amit már bármilyen égetőprogram tud kezelni.

147 Bootloader:  letöltő  program.  Lehetséges  a  mikrovezérlőbe  olyan  programrészletet  írni,  ami  –  felhasználói 
beavatkozásra  –  valamilyen   kommunikációs  protokollon  (pl.  USB)  keresztül  érkező  információval  tölti  fel  a 
programmemóriát  (kivéve  a  letöltőprogram által  elfoglalt  memóriaterületet).  Egy ilyen  letöltőprogram nagyban 
megkönnyíti  a  fejlesztést,  ill.  a  későbbi  update-eket,  hiszen  nem kell  majd  egy  külön  programozó  áramkör  a 
firmware frissítéséhez. 

148 Igazából számunkra itt most csak a Clear program memory upon loading a program lehetőség fontos hogy ne 
legyen bejelölve. Azonban célszerű, ha a projektek fordításánál se a konfigurációt, se a felhasználói azonosítót, se az 
EEPROM adatmemóriát nem töröljük.

149 Szintén a Microchip honlapjáról tudjuk letölteni a fordításhoz szükséges MCC18 nevű komponenst.
150 A  teljes  programmemóriát,  a  konfigurációs  bitekkel,  és  felhasználói  azonosítóval  exportáljuk  INHX32 

fájlformátumba.
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7.3.4 Változtatás a klónáramkörön

A 104. oldalon már ismertetett problémát egyszerűen megoldhatjuk, ha egy külön LED-et 
csatlakoztatunk  a  mikrovezérlőhöz,  és  ennek  segítségével  jelezzük  a  Programmer  –  To  –  Go 
funkciót.  Hozzá  kell  tennünk,  hogy  ez  így  kulturáltabb  is  mint  az  eredeti  verzió,  hiszen 
státuszjelentésre nem túl korrekt a tápfeszültséget felhasználni. A módosítások elvégzéséhez meg 
kell  változtatni  a  nyáktervet,  és  a  firmware-t  is.  Ezeket  a  módosításokat  a  dokumentáció 
elkészítésekor  részben  már  elvégeztük,  mind  a  módosított  nyáktervet,  mind az  új  firmware-t  a 
http://plc.mechatronika.hu,  vagy  a  www.picnick.hu weboldalról  le  lehet  majd  tölteni.  A 
módosításokról egy külön rövid leírást is készítünk.
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Irodalomjegyzék

8 Irodalomjegyzék

• http://plc.mechatronika.hu  

• www.alldatasheet.com  

• www.microchip.com  

• Pickit2 User Guide

• ICSP User Guide

• PIC18F2550 adatlap
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